BENEATH THE CHERRY BLOSSOMS: AN EXPLORATION OF
MOTION DESIGN FOR THE MULTIMEDIA DESIGNER

A Project
Presented
to the Faculty of
California State University, Chico

In Partial Fulfillment
of the Requirement for the Degree
Master of Arts
in
Interdisciplinary Studies
Applied Computer Graphics

by
© Adam Dean Clark 2011
Summer 2011
BENEATH THE CHERRY BLOSSOMS: AN EXPLORATION OF
MOTION DESIGN FOR THE MULTIMEDIA DESIGNER

A Project

by

Adam Dean Clark

Summer 2011

APPROVED BY THE DEAN OF GRADUATE STUDIES
AND VICE PROVOST FOR RESEARCH:

_________________________________
Eun K. Park, Ph.D.

APPROVED BY THE GRADUATE ADVISORY COMMITTEE:

Sara A. Trechter, Ph.D.
Graduate Coordinator

Clarke H. Steinback, Ph.D., Chair

Barbara Sudick, M.F.A.

Frank Armstrong, M.F.A.
PUBLICATION RIGHTS

No portion of this project may be reprinted or reproduced in any manner unacceptable to the usual copyright restrictions without the written permission of the author.
ACKNOWLEDGMENTS

From my undergraduate years in the Communication Design Department to my learning and teaching opportunities in the Applied Computer Graphics Department, my experience at California State University, Chico has been invaluable and I would like to thank a number of people for their contributions to my personal and professional growth.

During my undergraduate years, I received direction for my passion in the arts as well as a foundation of design knowledge from professors like Frank Armstrong, Barbara Sudick, Byron Wolfe, and Gregg Berryman. I would like to express appreciation to Nanette Wilde who allowed me the freedom to more fully explore my artistic abilities and creative interests, and also to Sara Trechter who supported my success and provided guidance at a critical point in my academic career. Lastly, I would like to thank Clarke Steinback for countless hours of his time and for aiding me throughout the course of my graduate studies. Thank you for being my teacher and friend.

I would also like to acknowledge my family, all of whom have believed in me and my creative abilities. I would like to thank my wonderful parents, Kelly and Linda Clark, who have instilled in me the motivation and confidence to pursue my passions in life. Lastly, I would like to express endless gratitude to my amazing wife, Rachael – my best friend. Thank you for your continuous support, patience, paper editing, pep-talks, and love. I couldn’t have done this without you.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Publication Rights</th>
<th>iii</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgments</td>
<td>iv</td>
</tr>
<tr>
<td>List of Figures</td>
<td>vii</td>
</tr>
<tr>
<td>Abstract</td>
<td>ix</td>
</tr>
</tbody>
</table>

## CHAPTER

<table>
<thead>
<tr>
<th>I. Introduction</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose of the Project</td>
<td>2</td>
</tr>
<tr>
<td>Scope of the Project</td>
<td>2</td>
</tr>
<tr>
<td>Significance of the Project</td>
<td>4</td>
</tr>
<tr>
<td>Limitations of the Project</td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>II. Review of Literature and Related Media</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Evolution of Motion Design: Origins of Moving Imagery</td>
<td>9</td>
</tr>
<tr>
<td>The Innovators of Motion Design: Film Title Sequences as an Art Form</td>
<td>16</td>
</tr>
<tr>
<td>Current Motion Design: Applying the Fundamentals</td>
<td>21</td>
</tr>
<tr>
<td>Current Motion Design: Conceptualization for Professionals</td>
<td>27</td>
</tr>
<tr>
<td>Current Motion Design: Tools and Equipment</td>
<td>30</td>
</tr>
<tr>
<td>Current Motion Design: Advanced Animation Techniques</td>
<td>34</td>
</tr>
<tr>
<td>Current Motion Design: Video Output Criteria for Playback</td>
<td>37</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>III. Treatment of the Project</th>
<th>42</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Production: Brainstorming</td>
<td>44</td>
</tr>
<tr>
<td>Pre-Production: Storyboarding and Animatic</td>
<td>47</td>
</tr>
<tr>
<td>Production: Creation of the Artwork</td>
<td>49</td>
</tr>
<tr>
<td>Production: Animation Setup in After Effects</td>
<td>58</td>
</tr>
<tr>
<td>CHAPTER</td>
<td>PAGE</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>Production: Moving a CG Camera through 2.5D Space</td>
<td>63</td>
</tr>
<tr>
<td>Production: Applying Advanced Animation Techniques</td>
<td>73</td>
</tr>
<tr>
<td>Production: Creating and Compositing a 2D Frame-by-Frame Animation</td>
<td>80</td>
</tr>
<tr>
<td>Production: End Details and Effects</td>
<td>87</td>
</tr>
<tr>
<td>Post Production: Video and Sound Editing</td>
<td>99</td>
</tr>
<tr>
<td>Post Production: Compression and Output for Multiple Playback Devices</td>
<td>103</td>
</tr>
<tr>
<td>IV. Reflections and Recommendations</td>
<td>107</td>
</tr>
<tr>
<td>Final Recommendations: The Importance of Pre-Production Work</td>
<td>108</td>
</tr>
<tr>
<td>Final Recommendations: Creating the Artwork</td>
<td>109</td>
</tr>
<tr>
<td>Final Recommendations: Animation Techniques and Effects</td>
<td>111</td>
</tr>
<tr>
<td>Final Recommendations: Video and Sound Editing</td>
<td>113</td>
</tr>
<tr>
<td>Final Recommendations: Compressing for Online Viewing</td>
<td>115</td>
</tr>
<tr>
<td>Conclusion</td>
<td>116</td>
</tr>
<tr>
<td>References</td>
<td>118</td>
</tr>
</tbody>
</table>

Appendices

| A. Definitions of Terms                                 | 124  |
| B. Story Boards                                         | 129  |
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The Production Pipeline used for <em>Beneath the Cherry Blossoms</em></td>
</tr>
<tr>
<td>2.</td>
<td>Photoshop Brush Settings Panel</td>
</tr>
<tr>
<td>3.</td>
<td>An Image Series Showing the Process of Combining Traditional and Digital Media</td>
</tr>
<tr>
<td>4.</td>
<td>The Adobe After Effects Workspace</td>
</tr>
<tr>
<td>5.</td>
<td>The After Effects Composition Settings Window</td>
</tr>
<tr>
<td>6.</td>
<td>PSD Layers Arranged Within the Timeline Panel, with the Camera Zoom Property and 3D Toggle Buttons Highlighted</td>
</tr>
<tr>
<td>7.</td>
<td>The Composition Flowchart Within After Effects</td>
</tr>
<tr>
<td>8.</td>
<td>The Sure Target Effects Control Panel</td>
</tr>
<tr>
<td>9.</td>
<td>The Timeline Panel with Keyframed Targets in Place</td>
</tr>
<tr>
<td>10.</td>
<td>The Final Compositions Within the Main Movie Timeline</td>
</tr>
<tr>
<td>11.</td>
<td>The Composition Panel Displaying Two Horizontal Views of the Project</td>
</tr>
<tr>
<td>12.</td>
<td>The Graph Editor Before Keyframes Were Adjusted with Bezier Curves</td>
</tr>
<tr>
<td>13.</td>
<td>The Graph Editor After Keyframes Were Adjusted with Bezier Curves</td>
</tr>
<tr>
<td>14.</td>
<td>A View of the Timeline Panel for the Butterfly Composition</td>
</tr>
<tr>
<td>15.</td>
<td>A view of the TV Paint Workspace with the Light Table Turned On</td>
</tr>
<tr>
<td>FIGURE</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>16.</td>
<td>The Render Settings in TV Paint, Set to Export a PNG Sequence</td>
</tr>
<tr>
<td>17.</td>
<td>The Render Settings in Photoshop Set to Export a PNG Image Sequence</td>
</tr>
<tr>
<td>18.</td>
<td>The Frame Rate Interpretation for the PNG Image Sequence in After Effects</td>
</tr>
<tr>
<td>19.</td>
<td>An Example of an Ink Bleed Mask Being Revealed over Time</td>
</tr>
<tr>
<td>20.</td>
<td>A Close-Up View of the Timeline Panel. Here, a Luma Matte Has Been Applied</td>
</tr>
<tr>
<td></td>
<td>to the PSD Layer “Bamboo_5”</td>
</tr>
<tr>
<td>21.</td>
<td>The Results of an Ink Bleed Mask Applied to PSD Layers</td>
</tr>
<tr>
<td>22.</td>
<td>The Particular Effects Panel Broken Up into Segments to Display the Settings</td>
</tr>
<tr>
<td></td>
<td>for the Waterfall Effect</td>
</tr>
<tr>
<td>23.</td>
<td>The Particular Effects Panel Settings for the Falling Blossoms Effect</td>
</tr>
<tr>
<td>24.</td>
<td>The Work Area Bar Defining a Segment to be Rendered Within the Timeline</td>
</tr>
<tr>
<td>25.</td>
<td>The After Effects Render Settings Menu Ready for Export</td>
</tr>
<tr>
<td>26.</td>
<td>The Premier Pro Timeline Panel</td>
</tr>
<tr>
<td>27.</td>
<td>The Keyframed Audio Fade-Out Within the Effects Panel</td>
</tr>
<tr>
<td>28.</td>
<td>The Export Settings in Premiere Pro for Online Playback</td>
</tr>
<tr>
<td>29.</td>
<td>The Bitrate Settings Adjustment Made for Computer Playback</td>
</tr>
</tbody>
</table>
ABSTRACT

BENEATH THE CHERRY BLOSSOMS: AN EXPLORATION OF MOTION DESIGN FOR THE MULTIMEDIA DESIGNER

by

© Adam Dean Clark 2011

Master of Arts in Interdisciplinary Studies

Applied Computer Graphics

California State University, Chico

Summer 2011

Through the production of an original motion design piece, this project will demonstrate and document how a single multimedia designer can produce an animation from conceptualization to a final output ready for audience viewing on multiple playback devices. The animation, *Beneath the Cherry Blossoms*, is a mock movie title sequence that includes typography and original painted/illustrated nature scenes inspired by Chinese brush painting and Japanese sumi-e artwork. It incorporates both traditional and digital media and utilizes keyframing and frame-by-frame animation of 2D imagery. In addition to a step-by-step treatment of the work, reflections and recommendations are made, including an analysis of software, technical discoveries, and the personal and organizational skills necessary for a motion design production.
Although the primary focus will be on the creative and technical process for producing and moving the imagery, audio editing and obtaining rights to music, along with video compression for efficient playback will also be addressed. Various digital software (e.g., Photoshop, Corel Painter, TV Paint, After Effects, Premiere Pro, etc.) and its application to the project will be discussed in great detail, which is why this is recommended reading for an audience with a strong foundation in digital art and computer graphic software. The titling and organization of all headings and sub-headings is meant to allow greater accessibility for those with interests limited to specific techniques or topics.
CHAPTER I

INTRODUCTION

From cardboard cutouts moved by hand for a projected photo sequence to today’s flashing of big screen advertisements in Times Square and beyond, the careful movement and manipulation of imagery to create an intended effect, or motion design, has gradually become infused into our daily lives. This rapid growth has coincided with the development of technology, which has transformed how moving imagery is created and even the way in which it is presented to its audience. The introduction of the computer, and increasingly advanced graphic software has proven vital in the production of motion design for the 21st century.

The past decade has given way to an outcropping of design studios, production companies, and multi-million dollar corporations with highly specialized and multi-faceted production teams creating an array of digital media for the world. Just as technology has acted as the driving force for the expansion of large-scale production companies, it has also provided encouragement for the individual digital artist or multimedia designer. What was once considered complex and feasible only through the coordination of an entire creative team can now be accomplished by one imaginative mind with the right technical know-how. With the help of tools accessible to the general public (e.g., professional software and a computer that adequately supports it) the individual is empowered to embark on his/her own creative journey. As visual effects
pioneer Robert Abel once stated, “Technology just frees us to realize what we can imagine. It’s like being given the power to do magic” (Krasner, 2004, p. 35).

Purpose of the Project

While harnessing current technology as well as skills spanning multiple disciplines, I wish to create a title sequence animation and document the in-depth process of production and delivery (i.e., from early conceptual phases through final output). Although the animation will not be completed for a client, this project will demonstrate and discuss how a single multimedia designer can produce a deliverable product, ready for audience viewing. In doing so, it is my primary goal to more closely examine a variety of animation techniques and concepts, while addressing other relevant criteria such as audio/video editing, output/compression, application of software, and project management.

Additionally, because each motion design production is as unique as the artistic process and execution of each designer, a thoughtful approach will be taken for the titling and organization of all headings and sub-headings. This categorized approach is meant to address the needs of those with varying interests, skill levels, and specializations, so that this paper may also be used as a quick reference guide for those who do not wish to read through all of the material covered.

Scope of the Project

The animation, itself, will be in the form of an opening credit/title sequence for a fictitious film I have entitled, Beneath the Cherry Blossoms. As an opening title, it will apply the fundamentals of graphic design with special consideration given to
typography selection, composition of imagery, and color theory. The imagery will be original artwork incorporating both traditional and digital media. This work will be based on Chinese brush painting; an ancient oriental painting technique which utilizes simple, sometimes very spontaneous brush strokes to capture the expression or feeling of objects, shapes and imagery. Advanced animation techniques will be applied to produce smooth movements that flow with the tempo of background music to create a gentle ambiance.

The viewer will be “flown” through the imagery—a series of nature scenes—while film credits are slowly revealed. The length of the animation will be kept to a minimum (i.e. no longer than two to four minutes). All work is to be completed on a custom-built desktop computer utilizing a variety of professional software (including Photoshop, Corel Painter, TV Paint, After Effects, Premiere Pro, etc.).

The written portion of this project will be presented in a “ground-up” approach with research that covers the history and fundamental techniques of animation (see Chapter II) and a section that defines all relevant terms (see Appendix A, Definition of Terms). In detailing the execution of the project, written material will address some of the creative process, but quickly transition into more technical criteria and advanced practices for the aspiring multimedia designer (see Chapters III and IV).

Although it is my intention to make this written material more accessible reading for a wider audience, those beginning to explore or widen their abilities in the field of motion design should find it most informative and helpful. Because numerous professional computer graphics programs will be discussed, it is recommended that, at a minimum, the reader have prior experience or some fundamental knowledge of working with digital imagery. Those with a background limited only to traditional arts may find
inspiration in the possibilities that digital media has to offer; however, without some previous experience or any existing knowledge of digital software, may be overwhelmed by the amount of technical content in this particular area. In addition to some basic exposure to digital software and the process of creating static imagery, they may also possess an active interest in learning new tools and techniques for the purpose of expanding their skills in order to become a more proficient designer. More specifically, multimedia designers wishing to create, polish, and deliver a finished production, will find helpful tools for executing a project independently from start to finish.

Significance of the Project

A wavering economy and inconsistent job market have given rise to a number of trends the last couple of years, significantly changing the way work is being done. Accessing the “virtual workforce” of talented individuals to fulfill job duties online on a need basis is proving to be a very cost-effective strategy for employers (Lewis, 2011). More businesses, large and small, are opting to hire professionals on a “flexible contract” or project-to-project. The Bureau of Labor Statistics (BLS) reported that 68% of hiring in 2010 was contract-based. Thirty percent of the nation’s workforce is now made up of independent workers and the number is expected to reach up to 40% within the next decade (Lewis, 2011; Revell, Bigda, & Rosato, 2009).

According to a quarterly report from Elance, the employment leader in the virtual job marketplace, online employment is at an all-time high as “jobs posted by businesses seeking talent grew 52% year-over-year” (Strauss, 2011). Those involved with technology (in both creative and information technology) are the highest in demand
The BLS also reported that overall employment for multimedia designers (specifically those doing animation and effects for film/video, advertising, or web) is expected to rise by more than 14% by 2018 (Locsin, 2011).

These numbers give a positive outlook for the future of the multimedia designer, many of whom are also discovering the added benefits of conducting work online from the comforts of a home studio. However, while online contract work is growing at an exponential rate and providing appealing opportunities for those with careers in technology, this growth is also encouraging an increase in competition (Newman, 2010). As stated in the BLS report on the career outlook for multimedia professionals, “Competition for these jobs will be keen because more talented people exist than there are jobs” (Locsin, 2011).

Learning about the variety of tools and methods applied during the production process on a project such as Beneath the Cherry Blossoms will not only give the aspiring multimedia designer insight on how a digital animation can be created, but also help them understand what it takes to widen their experience in multiple disciplines. Whether working independently or as part of a production team, having a versatile and adaptable skill set can empower the individual by making it possible for them to take on a multitude of work and fulfill multiple job roles as needed. Not only is this a way for the multimedia designer to become an indispensable member of a team, but it may also allow them to shift between roles depending on available contract work. Similarly, being able to execute multiple roles means the designer can complete a variety of smaller projects independently without the need to outsource work, which also may allow them to bid on potential projects at a more competitive rate. Ultimately, in a job market that is constantly
shifting, those who can rise to a wide variety of challenges are going to be the ones who are able to find and maintain consistent work ensuring a successful career for the future.

Limitations of the Project

Because this project is deadline-based, time is the most obvious limitation. In production of a complex animation, it is common for a team of designers to work together and perform various specialized tasks in coordination with one another. In the industry, time is of the essence and with multiple artists completing different portions of the production it is undeniable that more work may be accomplished in a shorter period of time. While I am confident with my drawing skills and the quality of the work that I can produce, I also realize that being overly meticulous can slow down the production process significantly. In order to complete all of the tasks necessary for this project independently, I know that the amount of content and/or its quality will need to be determined based on the time allowed.

It is important that I also point out some of the limitations of taking on an ambitious project alone. I realize that while working independently, it will be more difficult to enlist the help of others. The central advantage often associated with working on a successful team of artists/designers is having frequent opportunities to share ideas, collaboratively troubleshoot, and give guidance to one another throughout the production. Occasional advice from faculty and my colleagues as well as from forums and other online resources will provide much needed support, but nothing substitutes the support of having multiple professionals invested in a common goal.
That being said, as the only individual working on the entire piece, my level of experience in several different areas of production will directly impact my projected timeline. Although I have tried to allow time buffers for necessary research, unanticipated or miscalculated tasks may create the need for more research and lengthier troubleshooting, which will also affect the amount/quality of artwork I am able to produce. Multimedia designers should keep in mind that working on a large scale animation from start to finish requires proficiency in all stages of the production process and a variety of roles that may need to be filled, (e.g., illustrator, designer, animator, audio and sound editor, computer technician, etc.). Lack of comprehension and experience in any of the areas listed can hinder time of completion drastically.

As any artist/designer knows, quality tools and supplies are crucial for producing professional work. With regard to this project, accessibility to both traditional media tools and digital software/tools is necessary. Art supplies are not cheap, and access to supplies in terms of time and cost can affect the production. While digital software may not physically run out, it does become outdated, and staying up-to-date can be extremely expensive. In a competitive industry where large companies are continually re-designing and creating new software packages that run faster, smoother, and are more user-friendly, it may be difficult to determine a wise purchase. Similarly, computer components are always changing and improving at an astounding rate. Consequently, cost becomes a critical issue as the digital artist must frequently update the machine used to create their work in order to support advancements in software.

Saying that the computer is an important tool in this process is an understatement. Without the computer, the work done on this animation project simply
could not be achieved. Unfortunately, hardware failure and technical issues are known to occur and the consequences can be detrimental to the creative process and workflow. With the use of power-hungry software which pushes hardware to its furthest limits, computer crashes can be a regular occurrence and are a very real threat for artwork that is stored digitally. It is up to the digital artist to have some knowledge in how to make adjustments when hardware is malfunctioning or simply not running at its full capability.

In order to efficiently run the software required for the completion of this project, I have customized all the components of my personal desktop computer. Although it is a machine capable of processing graphic-intensive imagery, I will be running a few trial versions of newer software in addition to supporting my existing software, so the technological risks and possible limitations may also affect production.
CHAPTER II

REVIEW OF LITERATURE AND RELATED MEDIA

In an effort to understand the roots of motion design and how it has evolved, it is important to take a look at the early forms of moving imagery. This chapter begins by focusing on the innovators and the breakthroughs in the field of motion design and animation. More specifically, it will address the history of character animation as well as fine art animation and the transition to moving imagery as a new art form. Furthermore, an overview of design principles and conceptualization along with animation techniques, tools and equipment, will be discussed, which will present material relevant to the title sequence animation that I intend to create. Lastly, important technical aspects regarding digital video will be addressed. In particular, the variety of file types that exist as well as the different devices used to view/display motion graphics, the importance of compressing video files, and common frame dimensions and frame rates.

The Evolution of Motion Design: Origins of Moving Imagery

The Early Days

Presentations of moving imagery can be dated back as far as the early 1800s when a number of optical inventions such as the “praxinoscope,” and “zoetrope” became popularized. While each device differed slightly, the concept remained the same. The
user would peer through a small peephole, or scope while the device turned or rotated a number of sequential images in rapid speed. This tricked the viewer’s eye into perceiving the images as a continuous looping movement even though they were only viewing each image for a split second at a time; a phenomenon later dubbed “the persistence of vision” (Hahn, 2008; Williams, 2001).

With the invention of celluloid film ribbon in 1889, it was possible for long sequences of photographs to be contained on a reel. By 1894, parlors in New York City, London, and Paris began projecting moving photographs through devices called “cinematographs” onto large screens for public viewing and the age of cinema was born (Krasner, 2004).

Character Animation and Animated Feature Films

A little more than a decade later, comic artists and illustrators began experimenting with moving drawings for the purpose of viewing on the big screen. A Canadian cartoonist named Winsor McCay began drawing his cartoons on separate cards so that each drawing followed the other in a sequential series depicting a brief scene in which a character engaged in an act of movement. He then photographed each drawing in sequential order with a film camera so that the images could be played back on a projection screen (Bendazzi, 1994). Today, this method of creating artwork one frame at a time for playback is called frame-by-frame animation, and its methods are still applied in digital software (Krasner, 2004).

In 1910, Earl Hurd developed the cel animation process which would streamline the frame-by-frame process and is recognizable in many of the classic
cartoons and Disney movies. This technical breakthrough involved the creation of individual ink drawings on translucent celluloid sheets, which could then be overlaid on top of a background painting. This allowed artists to focus on creating the movement of a character or object without having to repeatedly re-create the background image for a particular scene, thereby reducing the amount of time for production. The next decade would give way to a number of animated shorts involving the cel process (Crafton, 1982). Soon, a handful of small animation studios began springing up as the animation industry gained popularity with audiences. Featured characters like Felix the Cat, Betty Boop, and Woody Woodpecker re-appeared in short cartoons and became iconic figures of the early 20th century (Krasner, 2008).

One of the small studios that formed in the blooming age of animated cartoons was Disney Brothers Cartoon Studio in 1923. Before Walt Disney, cartoons were generally made to make audiences laugh by putting a character through a series of comical events known as “gags.” By continually stressing the importance of story and character, Disney and his animators transformed lifeless drawings into believable characters that audiences could relate to. One of those animators, Wilfred Jackson explains:

Walt wanted his drawings that were animated to seem to be real things that had feelings and emotions and thoughts, and the main thing was that the audience would believe them and that they would care what happened to them...and he used to stress that! (Thomas & Johnston, 1981, p. 35)

Disney’s development of a complex camera system in the late 1930s provided another breakthrough in moving imagery. Previously, camera techniques were fairly crude and could only be suspended above the artwork, which resulted in one shot
downwards and did not allow for much flexibility. Cels would be placed on the table and held down by a single sheet of glass and the cameraman would then capture the exposure for the single frame, or cel. Walt was continually trying to develop better methods that would allow for easier camera control and more creative shots like side-to-side pans, and in-and-out zooms.

After years of refinement, the product of his labors was his multiplane camera, a revolutionary device that stood almost twelve feet tall and required four to five men to operate. It had six levels stacked one-on-top-of-the-other. Each level could hold a single piece of glass horizontally (Thomas & Johnston, 1981). Artists would paint objects such as trees and foliage for a particular scene directly onto their glass canvas, creating several layers of glass paintings to create an environment with depth and detail. The camera was stationed high above the levels looking down on the scene and bright lights lit the glass. Operators manually slid the glass sheets independently at careful calculations in order to get just the right effect. Each time the glass was adjusted, the camera operator would take the exposure frame-by-frame, eventually creating the illusion of movement within a scene (Hahn, 2008).

Without the limitation of one camera shot of a painting on a single, flat surface, the multiplane camera and layers of glass paintings, created more dimension and space for imagery to be manipulated. Since objects and backgrounds could be broken up into levels, a flower in the foreground would have more clarity than a tree in the distance, and each object could move independently of the other. Additionally, more complicated pans and zooms could be accomplished through the use of a more complex system layers. Extensive use of the multiplane camera system was first seen in Disney’s first ever full-
length animated feature film *Snow White and the Seven Dwarfs* (1937), and the screen became a window to imaginative worlds full of depth and realism that astounded viewers. Audiences were not just entertained by the film; they were captivated (Thomas & Johnston, 1981).

While the camera delivered astonishing imagery, it was labor intensive and incredibly expensive to repair and operate. Later, mechanical versions of the camera were produced that eliminated the need for multiple operators. This version of the camera would be used until computer software began replacing the large camera units in the 1990s. Even in the digital age, many of Disney’s fundamental principles for making successful moving imagery on-screen are still practiced. The idea of flat, two-dimensional images existing in three-dimensional space has since been referred to as “2.5D” among those in motion design (see Chapter III, *Moving a CG Camera through 2.5 D Space*).

**Fine Art Animation**

Just as the animation field began to expand by delivering audiences memorable on-screen characters, a number of studio artists and painters began experimenting with moving imagery as an art form. The 1920s made way for a swift movement toward abstract painting, sculpture and filmmaking in the forms of new movements called dadaism and surrealism. Post World War I, European society was bitterly rebelling against the constraints of conflicted governments. In search of a new creative freedom in all forms of art, poets, painters, and filmmakers began rejecting classical and traditional practices. Visually, the new styles that emerged involved
stronger geometric shapes, spontaneity and often times illogical contexts (Krasner, 2004; Meggs, 1998).

One of those artists, a European dadaist named Hans Richter, began developing ways to integrate his abstract paintings with motion by using film as his new form of canvas. Eventually, Richter began pushing the limits of the medium by experimenting with live action footage to create shocking and disturbing imagery people had never before seen. His short film, *Ghosts Before Breakfast* (1927), consisted of flying hats, disappearing objects, and scenes running in reverse—the first examples of on-screen special effects.

New Zealander surrealist, Len Lye, was one of the first artists to paint and scratch imagery directly onto the film, using the frame-by-frame method to get his creations to move in time. By working directly on the film, Lye eliminated the need for a camera thereby speeding up his production time. His cinematic endeavors included a 1929 animated short titled *Tusalva, Samoan for “things go full cycle.”* The peculiar imagery featured cell-like organisms morphing and multiplying and were his representation of “the beginnings of organic life.” Each frame was created by hand and took two years to complete (Krasner, 2008). Similarly, Canadian artist Norman McLaren, known in the early days as “a poet of animation,” used film as his canvas. McLaren created rich textures and patterns by scratching and dabbing paint onto film with razor blades, paint brushes, sponges and spray paint.

A German woman, Lotte Reiniger, made a lifetime career out of her unique method of telling short stories through the use of cardboard cut-outs. Once the cut-outs were laid out on a piece of glass and backlit, each movement was shot with a film camera
frame-by-frame. The end product was silhouette images, now called “shadow puppets” depicting detailed characters and intricate backgrounds that moved and came to life. Her 1926 film, *The Adventures of Prince Achmed* can arguably be called the very first full-length animated feature film, before *Snow White*. Her silhouette style didn’t fit in as a recognized form of character animation in a time when painted cartoon characters ruled the screen. Still, Reiniger completed nearly 70 animated films throughout her lifetime, all composed in her unique silhouette style featuring imaginative characters and stories (Moritz, 1996).

Sixty years before the first music video would be played on MTV, German artist Oskar Fischinger was merging music and abstract imagery in ways that would inspire generations of animators to follow. Fischinger worked briefly at MGM and Paramount after he moved to Los Angeles to flee Nazi Germany. Surprisingly, Hollywood producers did not take interest in his abstractions. Award-winning designer and fan of Fischinger, Chip Kidd explains, “He (Fischinger) was going in a completely different direction than any other animator at the time... He was really exploring abstract patterns, but with a purpose to them. Pioneering what technically is the music video” (as cited in Solomon, 2006). Eventually, Walt Disney took interest in Fischinger’s work and hired him to create a large segment in Disney’s film, *Fantasia*, in which he animated mountain peaks and violin bows moving in rhythmic harmony to *Toccata and Fugue in D Minor* by Johann Sebastian Bach (Solomon, 2006).

In the days before digital technology, these creative minds utilized any form of media they could apply to film, to deliver imaginative, memorable creations that entertained audiences for years. Many of their techniques were crude and experimental
and took painstaking hours of concentration and attention to detail. Yet, they would be known as the innovators of moving imagery as their works would provide the foundation for technological advancement in their field and continue to inspire the many artists to follow.

The Innovators of Motion Design: Film Title Sequences as an Art Form

In the earliest days of cinema, credits for those involved in the production of a film were shown throughout the presentation. Before long, they were being presented at the very beginning of the film on “title cards” that featured white type on a black background because this method was most legible when projected on a screen. Eventually, large studios began hiring letter artists to hand-draw the titles and credits as well as to style the font to fit the subject matter of a particular film. Some began incorporating fancy lines and simple graphic elements to enhance the title. In the late 20’s, Disney was the first to have characters appear on the title card when he had Mickey and Minnie Mouse pictured on either side of the text for 1929’s short cartoon, Plane Crazy (May, 2010). However, opening film titles would continue to stay relatively basic until the 1950s when the first moving title sequences began to change the way movies were watched. These newly combined versions of design with animation were the beginnings of “Motion Design.”

Saul Bass

Most in the motion design field would agree that it was renowned graphic designer Saul Bass who was responsible for invigorating title design and inspiring other designers to try their part at creating dynamic title sequences. Throughout his career he
created opening sequences for the films of many big name directors such as Alfred Hitchcock, Martin Scorsese, and Stanley Kubrick. By incorporating moving graphical elements reminiscent of the experimental fine art animations of the 1920s, along with the text for the film credits, Bass was the first to involve the audience in the film from the very first frame (Drate, Robbins, & Salavets, 2006; Krasner, 2004). The 1955 film, *The Man with the Golden Arm*, included his most well-known work and is considered by many to be the film that revolutionized movie title sequences as a new creative art form. As the title for the film appears in the opening credits, a series of lines form into an abstract black arm which appears to be retracted off the screen. The arm was a powerful symbol of the main character’s struggle with heroin addiction. As this metaphorical image garnered deserved attention and integrated the credits as a part of the film, this simple effect resulted in notes having to accompany the movie’s opening film reel that read, “Projectionists, pull curtain *before* titles.” Until then, the credits and the feature were distinctively separate, and curtains for movies would often remain closed until the lackluster credits were over and the main attraction began. Later, Bass would claim that he found his title sequence for *The Man with the Golden Arm* “disappointing… because it was so imitated” (Design Museum, 1998). In an interview, Bass once explained the significance of a good opening title sequence:

> My initial thought about what a title could do was to set a mood and the prime underlying core of the film’s story, to express the story in some metaphorical way. I saw the title as a way of conditioning the audience, so that when the film actually began, viewers would already have an emotional resonance with it. (as cited in Drate et al., 2006, p. 16)

Bass’ use of typography for the credits was equally innovative. He not only styled the type to fit the subject matter, he also animated it in ways that seemed to go
along with the underlying theme of the film. In the 1960’s thriller *Psycho*, the title breaks in half, giving implication to a deranged character’s split personalities. In *The Seven Year Itch* (1955), the text appears in abstract boxes that are separated to suggest the thin, but dividing walls of separation between the main characters and their neighboring apartments. In addition, the letter “T” in the word *Itch*, actually scratches itself for a brief moment. These very subtle additions and attention to detail were what made Bass such a profound title designer who would go on to make over fifty titles in all until his last in 1995 (Design Museum, 1998; Krasner, 2004).

**Friz Freleng**

Largely due to Bass’ work, film title sequences became quite trendy during the 1960s. In fact, the title for *The Pink Panther* (1963) created by Friz Freleng, an animator known for his contributions on the Looney Tunes cartoons, was so popular that the character featured in it became an icon of pop culture and was later given its own television series. The sequence, itself, is accompanied by catchy music and features a comical pink panther character that interacts with the moving type in a series of witty gags. The animation was much different from the low-budget cartoons of the time, and critics even commented that “the titles were better than the picture” (Krasner, 2004, 2008).

**Maurice Binder**

Most adult movie-goers would recognize the signature opening to all the Bond films with the camera peering down a gun barrel, followed by Bond entering its line of sight. He then turns, points his gun and a shot rings out, followed by a dripping red wash that fills the screen. This scene was designed by Maurice Binder along with the first title
sequence for a 007 film in 1962’s *Dr. No*. He created the shot by actually filming down the barrel of a .38 caliber handgun (Krasner, 2008). Binder would go on to oversee 13 more Bond title sequences in all until his last sequence in 1989’s *License to Kill* (Taylor, 2002). Some of the most memorable of his Bond titles were, *You Only Live Twice* (1967), *On Her Majesty’s Secret Service* (1969), and *The Spy Who Loved Me* (1977).

Although Binder oversaw many other film title sequences throughout his career, the majority of his Bond titles portrayed a very distinct style. The vibrant background colors surround sleek silhouettes of female figures which move gracefully and provocatively across the screen, often times wielding handguns, delivering a sense of danger and eroticism suitable for any of the James Bond scripts. These images accompanied with well-suited theme songs became a trademark for all James Bond films and were widely anticipated by viewers. Many motion designers since Binder have had the opportunity to contribute their own imaginative versions of James Bond title sequences, adding to what has now become a tradition.

Kyle Cooper

Many other designers followed in the footsteps of Bass and Binder, trying their part at movie title sequence animations by borrowing ideas and developing new ones, but it wouldn’t be until the 90’s when another talented designer would again re-invent how titles sequences were integrated into films. Kyle Cooper’s creation for the opening titles of 1995’s psychological thriller, *Seven*, was said to be “one of the most important (film) innovations in the 1990’s” by *The New York Times Magazine*. The creative genius of the title sequence for *Seven*, lies in the groundbreaking idea of immersing the audience inside the mind of the killer and, through various effects,
exposing/developing pieces of the character while rolling the opening credits. The imagery builds suspense by featuring provocative live action close-ups of fingernail cuttings, hair trimmings, and erratic handwriting, which deliver clues as to how the killer goes about his dark, methodical rituals, yet stopping short of giving the audience any telling information about who the killer might actually be. The typography for the credits, complete with ominous subliminal messages, was all hand-scratched by Cooper directly onto the filmstrip, which appeared to replicate Len Lye’s technique from the 1930s. The scratchy film effects along with the disturbing footage, hard cuts and rapid film flashes all accompanied with a song by Nine Inch Nails gives an intense feeling of unease, suitable for the film’s sinister theme (Braha & Byrne, 2011).

Since the creation of Seven, Cooper has founded two extremely successful design firms. Both Imaginary Forces (1996) and Prologue Films (2003) each with offices in Los Angeles and New York have created hundreds of openings for films, video games, and television shows.

He has appropriately been dubbed “the guy who makes title sequences better than the movie” by The Dawn of the Dead Director Zach Snyder for whom Cooper also created title sequences (Gibson, 2004). Other notable works of his include the lead-ins to Spider-Man, Sphere, Kiss Kiss Bang Bang, Mission Impossible, The Mummy, Wild Wild West, and the list goes on (Gibson, 2004). While each of the films themselves may not be movie classics, Cooper’s title sequences continue to engage and entertain audiences.

Summary

Innovators like Saul Bass, Maurice Binder, and Kyle Cooper transformed title sequences through unique motion and graphic design contributions. They were
responsible for distinguishing the title sequence while integrating it into the film and making opening credits more engaging for audiences. Through trial and error, study and experimentation, as well as creativity and wit, they developed ways to communicate to audiences with the movement and manipulation of shapes, designs, characters, and typography. Their work continues to be studied and reinvented in the ongoing effort to keep title sequences interesting while drawing appropriate attention to the film. Their brilliant use of fundamental design principles transcends the progression of technology and continues to inspire young artists, like myself.

Current Motion Design: Applying the Fundamentals

As the masters have demonstrated, creating an original title sequence animation that generates interest is all about the details. Pulling off a good idea means orchestrating certain elements of design so that it all comes together. Because moving imagery is composed of several static images, successful motion design rests largely upon the same foundational principles of graphic design. Projects simply become more complex as moving imagery incorporates additional criteria, such as animated typography or rhythm and tempo. Below is an overview of some of the fundamentals of graphic and motion design I wish to apply during production to create a title sequence that draws interest and is aesthetically pleasing.

Building Interest through Composition

Composition is the basis for which all pictorial forms are organized and displayed within a single, static image. In terms of motion design, good composition involves careful attention to the form and placement of any elements within the area of
the viewable screen, or frame, at any given time. This section on building interest introduces some of the factors a professional designer should consider when making decisions about composition. Each decision can have an enormous impact on how the viewer will interpret the information being presented (Krasner, 2004).

**Rule of Thirds.** Strategic placement of graphical elements and text in any composition will determine how and where the viewer’s eye will move throughout the viewing area. The rule of thirds is a well-known fundamental principle of photography and graphic design that translates well to any rectangular design image, whether on screen or for print. This principle consists of an image being broken down into thirds, horizontally and vertically, so that there are nine parts. To help visualize this, imagine two horizontal lines and two vertical lines spaced evenly over the image and intersecting. This will resemble a grid pattern similar to a tic-tac-toe game. (In most graphic software, any lines of reference or “guides” can be implemented with a grid tool.)

With respect to the rule of thirds, the four points where the lines intersect are the most important areas of the composition. Studies have shown that the viewer’s eyes often go to one of these intersection points more naturally, as opposed to the center of an image. It is this argument that photographer Darren Rowse uses to determine his most interesting shots. For the strategic placement of imagery in a motion graphics animation, it seems only logical that these same “points of interest” should serve as the intended the focal points (Rowse, 2006).

**Scale.** In addition to the placement of imagery, a variety of components can play a role in establishing visual contrast, which can make for more interesting compositions and give the designer more control over the overall message being
communicated. Scale is one of the most fundamental components used to create contrast. As larger objects naturally appear closer and smaller objects further in the distance, one can create emphasis on an area of particular interest as well as establish a hierarchy of the information. Large elements can also have a feeling of weight and mass, as smaller elements will seem lighter.

**Shape.** Utilizing varying shapes is another method used for creating contrast in compositions. A basic example would be framing a point of interest with a circle where the rest of the viewing area is broken up by rectangles. This slight adjustment will guide the viewers eye to an intended point of interest, once again giving more control to the designer in delivering his/her message.

**Proximity.** The spatial relationship of elements or proximity at which they relate is a way to establish a hierarchy of information. Attention can be directed to areas by indenting text or shapes left or right respectively. Given that audiences will predominately view information from left to right, elements and text at the far left will most likely be viewed first (O’Nolan, 2010).

**Positive vs. Negative Space.** All of the components mentioned also have direct influence over the amount of empty space, or “negative space” within a composition which can also be used to one’s advantage in delivering visual messages or emphasis. “Positive space” is areas that are occupied by elements inside the viewable area. “Negative space” is unoccupied space which provides breathing room for the eye. Positive space will most often create the point of interest as the viewers eye tends to look to areas which contain elements (Krasner, 2008).
Creating Mood and Contrast with Color

Given that different colors are symbolic and often carry strong emotional and cultural meanings, color plays an essential role in delivering a message to an audience. Familiarity with these meanings can help streamline color choices, and careful decisions can give the designer control over setting a desired mood. It is also important to recognize that different tonal values of one color may carry very different implications. For example, lighter blues are often associated with calmness and tranquility. Darker shades of blue stimulate feelings of depression or sadness. Likewise, light red induces more positive feelings of excitement and passion while darker reds have more negative associations like danger and irritability (Krasner, 2004). The following list shows common colors and their general cultural and psychological associations for North America:

- **Black**: Evil, mourning, and death.
- **White**: Pure, clean, and weak.
- **Red**: Violence, war, aggression, heat, love, excitement, passion, and danger.
- **Orange**: Light, happiness, nostalgia, tension, energy, and enthusiasm.
- **Yellow**: Joy, happiness, optimism, and caution.
- **Blue**: Coolness, calmness, sadness, serenity, scientific and clinical.
- **Green**: Quietness, envy, growth, fertility, and hope.
- **Violet**: Intrigue, luxury, and power (Braha & Byrne, 2011).

In addition to keeping these psychological connotations in mind when making individual color choices and conveying an intended mood, it is equally important to
consider the effect of the combination of colors appearing within a scene. Some color combinations will create dynamic contrast which can guide the viewer’s eye to points of intended interest. In any composition, cool colors such as greens, blues, and purples will recede to the back of the image evoking a sense of distance or coldness. Warmer colors like yellows and reds will jump to the front implying urgency, action and closeness (Braha & Byrne, 2011).

Various methods can also be used to intensify color or create more or less contrast and tension between them. This is done by grouping colors and maintaining their consistency thereby creating a color harmony. Generally, complimentary color harmonies (those opposite to one another on the color wheel) placed in close proximity to each other can create very intense contrast and some dramatic effects. An analogous color scheme (those adjacent to one another on the color wheel) would have less contrast therefore delivering a much more soothing and restful feel. Likewise, a monochromatic color scheme (lighter and darker tones of a single color) will also create a very soothing and sometimes dramatic composition (Krasner, 2004).

Applying Typography

Animated or kinetic type, delivers messages…literally. These messages are delivered more explicitly through the socio-cultural meanings of the words or letters, and also more subtly through the style of the typeface. In the event that unique characteristics of animated type transform it from plain text into physical shapes or graphics, it can play a key role in reinforcing the theme or mood of the animation. As Kyle Cooper states, “Type is like actors to me. It takes on characteristics of its own,” (Krasner, 2008, p. 195).
Because one of the most important elements in creating a successful movie title sequence is to select an appropriate font to accompany the imagery, having a library of options at the ready eases the process. To establish a broader selection, fonts can be purchased or downloaded free-of-charge for private and commercial use from sites like Fonts.com, 1001freefonts.com and acidfonts.com. Generally, the only way to see how a typeface will look is to actually test it in the composition, since each letter is unique and each word is a new composition of letters. Other decisions that must be made are size and letter spacing (tracking), whether letters will be uppercase or lowercase, or in bold or italics. Kyle Cooper explains the consequences of poor attention to typographic detail:

I’ve seen beautiful commercials where the photography is unbelievable, but then some graphic designer comes in and throws on some cheesy animation with bad type. They’ve taken this wonderful series of images and made it pedestrian. (Krasner, 2008, p. 200)

Once the aesthetics are decided upon, it is up to the designer how the type will be animated. The most efficient way to move type in animation software is to keyframe its movements on a motion path. Software such as Adobe After Effects have built-in effects which can be applied (i.e., shatter, glow, ripple, wave, etc.) to exaggerate the mood or message being delivered (see Chapter III, Adding the Final Details and Effects).

Just as graphical imagery can be created both in bitmap or vector formats, so too can type. Vector image formats will maintain sharp edges no matter how large or close they are viewed, making for easier manipulation of the shape, if alterations are desired. However, type created in bitmap format can have more flexibility when it comes to adding different styles and effects, such as shiny or textured surfaces, glows, or
beveled edges. With all the effects, styles, and movement, it is generally important to prioritize legibility, as typography is generally language first, imagery second.

Incorporating Rhythm and Timing

One generally associates rhythm with music and dance. It is the predicted repetition of the beat of a song that allows us to feel the music and begin tapping our foot or moving in unison with the melody (Krasner, 2008). As with motion in dance, the style in which graphic imagery is presented or moved has the potential to create a visual rhythm that generates a feeling or mood from the viewer. In the case of motion design, visual and audio effects may be applied in a sequential recurrence over time to establish a rhythm that is both seen and heard. By orchestrating visual and audio elements to create an integrated piece, a motion designer may further establish or reinforce the intended mood or effect on the audience.

Camera movements can be timed to slowly speed up the tempo and present scenes or transition them more rapidly. To emphasize a key position, a long pause may be applied by the sudden freeze of a frame with a still camera shot. This exercise of timing, or break in rhythm, is an example of how a designer can build anticipation to a climactic point of interest or focus (Krasner, 2004, 2008).

Current Motion Design: Conceptualization for Professionals

As Kyle Cooper states, “Each film is a different problem to solve, so each solution is different” (Braha & Byrne, 2011, p. 57). During the conceptualization process, it is the designer’s responsibility to conduct any research necessary for developing a firm understanding of relevant subject matter. For example, given that an opening title
sequence is an extension of the film, the objectives should in some way be linked to the content of the film. In addition to relevant research or criteria during the early creative stages, the designer should consider the following key questions: Who is the target audience? What mood and artistic style would be appropriate? What messages should be delivered? (Krasner, 2004).

Production Pipeline

In addition to defining objectives, this initial brainstorming process should also include the planning or detailing of a production pipeline. Before tackling any complex project, especially an animation involving multiple sources of media, it is wise to have a calculated plan. Setting out to create this type of production alone, especially when working on a deadline, is all the more reason to adhere to an organized set of scheduled tasks to streamline workflow and ensure time efficiency. In digital media, this framework of task organization is referred to as a “production pipeline” (O’Neill, Mavroidis, & Ho, 2007).

Given the diversity of software and the individual creative process, production pipelines for animations will have some variation, but three components remain the same: pre-production, production, and post-production. In order to create a production pipeline, a designer should attempt to calculate the general tasks that should fall within each of these categories. With the outline of these general tasks (each under one of the three main categories), more specific tasks may be detailed until all tasks that will be required in the completion of the project have been addressed.

Once the basic structure of a Production Pipeline is complete, it is easier to determine if tasks are arranged in the most logical order of execution, and re-arrange or
re-think the plan as necessary. While pipelines will vary depending on project size and complexity, pipeline generation for a large studio or individual designer should be defined in the early stages of pre-production (Skillset Animation, n.d.). In the end, this will act as the map for the project, as it will provide reference and ensure greater efficiency from start to finish. (For a figure depicting the production pipeline applied to this project, see Figure 1 in the opening of Chapter III).

**Storyboards and Animatics**

“...[T]echnology allows certain modes of production, it does not provide a good story or clear communication” (Drate et al., 2006, p. 6). Clear communication and intriguing story are the responsibility of a creative artist or multimedia designer. Fancy software and effects will not deliver a message alone. In order to finalize all concepts and put them in working order, a storyboard is absolutely essential.

A storyboard consists of a series of images (or frames) which present key points and events in sequential order. Put simply, its purpose is to tell the story of the proposed commercial, animation, or title sequence etc., with pictures. Not only is a storyboard a way to cohesively pitch concepts to a client, it also works as an organized visual map for the designer to draw reference from during the production process. Storyboards can be done with pencil on paper, or digitally in black and white or color. The purposes of the drawings are to be clear and informative, so fully detailed works of art aren’t necessary. Although, each frame should give a fairly good idea of the spatial relationship of elements, as well as how the camera will frame the composition. Arrows can be drawn to emphasize camera angles and movements. Often, storyboards are accompanied with brief, informative text below the frame which outlines what is
happening at each important point. The amount of frames will vary depending on the project. However, it is only necessary to create enough frames to emphasize the key events.

Storyboards show the evolution of moving imagery, statically. In order to gain a better sense of the timing, the motion of elements, and transitions, an animatic is created. An animatic is essentially a rough animated storyboard or slideshow, sometimes set to a soundtrack. The length of time of all camera shots, pauses and movements, as well as the length of the overall animatic should be very close to what the final product will be. Animatics have proven effective for large budget projects. Potential aesthetic and technical problems can be spotted before production has begun, and editing at these early stages is much more time and cost effective (Graphic Artists Guild, 2010; Krasner, 2004).

Current Motion Design: Tools and Equipment

Current Software

The list of software available for creating digital imagery for desktop users has grown immensely and each program has its own strengths and weaknesses. A lot of the software, such as Adobe Photoshop is “image editing” software and is used for manipulating digital imagery or photography. Many of these programs, including Photoshop, also have a variety of tools that can be used to design or “paint” imagery from scratch. Software such as Corel Painter, created specifically for digital painting has a variety of tools (i.e., paint brushes, pencils, markers, chalk etc.) which are intended to mimic traditional media. TV Paint is a program used mainly to create 2D animation; however, it too has both image editing and painting capabilities. Photoshop and Painter
are two of the more commonly used programs in the professional arena. They are also the most expensive and have the steepest learning curves (Pardew & Seegmiller, 2005). There are a variety of other more affordable programs available that will create digital imagery in much the same way, but for the writing of this thesis project, Photoshop, Painter, and TV Paint will be the software discussed in-depth in Chapter III.

All software mentioned above are bitmap (or raster) based software. That is, the imagery which they create is comprised of a series of very small squares or pixels assigned to exact locations, each representing its own color. When viewed together, our eye blends adjacent colors so we perceive the many bits of color as a complete image. A higher number of pixels per inch means a higher resolution, or increased clarity, of the image. The majority of imagery online are bitmap images. If you were to take one into graphics software and zoom in on it by 200-400%, the square pixels would be visible. The benefits of working with bitmap imagery are that there are a variety of file types they can be saved as and it is relatively easy to convert between the different formats. The drawback is that a bitmap image cannot have its size increased without suffering loss of image quality, which makes knowing and planning project sizing ahead of time essential (Pardew & Seegmiller, 2005).

The alternative to bitmap based software is vector based applications. Software like Adobe Flash, Adobe Illustrator, and Corel Draw create imagery in vector formats. Within a vector image are a series of mapped out shape paths of various sizes and colors taking the place of pixels. These paths can be created in the software with the use of “splines,” which can be manipulated to create or reconfigure any desired shape. The benefit of working with vector imagery is that resizing can be done without affecting
image quality. However, vectors do not work well for creating photorealistic detail and are best suited for graphical imagery and type (Braha & Byrne, 2011).

**Computer Hardware**

Over the last decade, high-end computers have become much more affordable to the average consumer and aspiring multimedia designer. There are also many ways to upgrade computer hardware at a reasonable cost. One of the most cost-effective upgrades one can make toward improving computer performance is by adding more Random Access Memory (or RAM) (Pardew & Seegmiller, 2005). During the time of this writing, the average desktop computer being sold has around 4 to 6 gigabytes of DDR3 RAM, which is more than enough to run high-end 2D graphics software. Another component important for the creation of graphics is the computer processor (or CPU). Put simply, this is the brain of the computer. The faster processing speeds a computer has, the less the user will have to wait for tasks to be performed (Pardew & Seegmiller, 2005). Processors come in many makes and models, but Intel has led the way in innovation for years. It is also essential to invest in a good video card when working with motion graphics. Higher-end desktop computers will come with middle to high-end cards already installed, but similar to RAM, video cards are easy to upgrade and are a cost-efficient way to improve computer performance. Obtaining a video card capable of running advanced 2D and 3D software requires spending anywhere between $100-$300. As with most digital technology, it is a good rule of thumb to stay with well-known brand names. EVGA, and Asus are two leading manufactures known for having good customer support. *Newegg.com* is an excellent source for purchasing and reading reviews on various computer components.
Digital Drawing Tablet

Besides an up-to-date computer, there are other tools worth investing in, which will make life for a multimedia designer much easier. When creating artwork digitally, a mouse is certainly capable of using all of the available tools in the software. Nevertheless, some may find clicking around a digital canvas to create imagery a bit daunting. The use of a pressure-sensitive digital drawing tablet replaces the use of a mouse with a stylus pen. As the pen is touched to the tablet and moved around, the digital painting tools in the software react to the movements in real time with pressure sensitivity. This allows lines and strokes to be drawn or painted with more accuracy and gives the artist a better feel of traditional pen on paper. With few different brands on the market, Wacom is regarded as the leading innovators of digital drawing tablets. They carry a variety of different sized tablets to suit the individual artist’s needs and budget (Krasner, 2004). For the medium-sized, 6x8-inch tablet one can expect to pay between $200-$400, depending on the model.

Digital Scanner

The use of traditional media is not absolutely essential for the development of a digital animation. However, implementing traditional media such as paint, pencil, ink, colored pencil, etc., and combining it with digital software can significantly increase the richness of imagery with regard to texture and color. A scanner provides the most efficient way to transfer any artwork created on paper to the computer so that it can be manipulated digitally. (Once artwork is scanned into the computer, Photoshop is especially good at manipulating and re-touching details to create endless possibilities.) There are a large variety of scanners, but all scanners are now capable of saving imagery
to a variety of the most commonly used file types, including JPEG, PNG, GIF, PSD, and PDF. For a medium sized unit with a scanning area of around 9x12 inches, one can expect to pay between $60-$200.

Current Motion Design: Advanced Animation Techniques

As previously discussed, the only way to create moving imagery in the early years of animation was to physically paint or draw new artwork for every single step, or frame of the movement in a sequence. This process was very time-consuming but gave the animator the ultimate control over every single intricate movement of a character or scene. While some still use the traditional methods of animating on paper, powerful software has forced the industry to adapt to faster, more efficient methods. With the large range of software available, as well as innovations such as the digital drawing tablet, the animation studio can now be brought to the home computer. Below are a few of the techniques I will apply in the creation of my animation.

Keyframing vs. Frame-by-Frame Animation

The process of moving imagery digitally revolves heavily around the technique of *keyframing*. Keyframing consists of strategically placing the target image in a starting point and an ending point and having the computer interpret the “in-between” movement taking place between the starting and ending state. When viewed in real time, the image will appear to make a fluid movement from keyframe-to-keyframe, thus completing the specific movement the animator intended. In addition to the position of objects, scale, color and orientation may also be keyframed. With this technique, it is not necessary to create new artwork for each individual frame of movement as it is with the
traditional frame-by-frame method previously discussed in this chapter (see Chapter II, *The Evolution of Motion Graphics: Origins and History, Character Animation*). While keyframing can speed up the animation process immensely, it can also limit what the animator has control over since the in-between frames are automatically generated by the computer (Krasner, 2004). Keyframing is best suited for 3D characters and designs, 2D graphical designs, moving typography or shapes that will maintain their general structure throughout the in-between frames. That is not to say that keyframe animation cannot be applied to 2D character animations. On the contrary, this method is commonly applied to characters in cartoons, movies and advertisements.

Since the two techniques of frame-by-frame animation and keyframe animation can be used interchangeably in software packages such as Adobe Flash and Toon Boom, it is up to the animator to know when it is best to implement each of the given methods. In general, frame-by-frame animation would be most ideal for a scene in which a character or object needs to have very natural and free flowing movements that would require the animator to have absolute control over each frame of movement (Krasner, 2008). There is a variety of professional software available (i.e., Adobe Flash, TV Paint, Toon Boom) that will mimic conventional methods of frame-by-frame animation without the need for paper, cels, or a camera. Alternatively, artwork is created for each frame digitally, and most often with the use of a digital drawing tablet. Consequently, production is much more cost efficient and streamlined since image modification as well as playback for the sake of testing a scene is much faster (Krasner, 2004).
The CG Camera and the 2.5D Environment

Computer generated cameras (CG) lie within the animation software and can add a variety of options and dynamic effects when animating. For example, a CG camera can be panned across a wide image of a horizon, zoomed into an area of interest, or even float or fly through imagery and type. CG Cameras can also incorporate or simulate the same visual aspects as their counterparts (i.e., focal length, depth of field, and camera movement) to provide a multidimensional space for animating. Movement can be keyframed along a specified motion path in X, Y or Z axes, giving a designer complete control over every framed shot at any given point in the timeline of an animation (Braha & Byrne, 2011; Krasner, 2004). Although a CG camera adds a wider range of options and effects, a simple project can easily become much more cumbersome when using one (see Chapter III, Moving a CG Camera through 2.5D Space).

The concept of moving flat 2D imagery within a 3D environment and filming it with a moving camera to give the illusion of depth and space is not a new one and should sound familiar. It is the same idea as the multiplane camera technique developed at Walt Disney Studios in the late 1930s (see Chapter II, The Evolution of Motion Graphics: Origins and History, Character Animation and the Animated Feature Films). Today, however, there is no longer need for a twelve-foot tall camera requiring a crew of five people to operate. Conveniently, the multiplane experience can be created within the animation software, all thanks to the virtual CG camera.
Current Motion Design: Video Output
Criteria for Playback

Before a multimedia designer begins creating the imagery for a motion design piece, it is vital that he/she knows how the final project is to be delivered to the audience. Based on the intended playback device(s), the designer may select the appropriate video dimensions, frame rate, file type, and compression settings. All these variables have direct correlation between the image quality, file size and overall playback performance of the final product.

Once digital files are created at a specific size and setting, it can be extremely difficult to have to backtrack to re-size imagery, convert file types or re-time animated elements. Below is an overview of the many output options which should be considered before/during production.

**Common Output Formats**

The final viewable file which is delivered to audiences can be viewed in a variety of formats. Today, the most common video file formats are Quicktime (.mov), Video for Windows (.avi) and Flash (.flv). All formats will play for both Mac and PC platforms. Quicktime was developed by Apple in the early 1990s to allow audio/video playback on Macintosh computers and has since become a widely used video format for PC users as well. While Quicktime content is commonly viewed online, it requires that a plug-in first be installed in the internet browser. Quicktime files can also be easily burned for DVD playback. Video for Windows, commonly called AVI (Audio Video Interleaved), was developed by Microsoft also in the early 1990s. AVI files are most often used for audio/video playback and storage on PCs and will play by default through
Windows Media Player. AVIs are not generally used for playback online since methods of embedding them into web pages is not as intuitive as other file formats, however, they are a good file choice for outputting to DVD. The majority of designers would consider Flash video to be the most effective way to broadcast video and interactive media across the internet (Krasner 2004, 2008). Many websites popular for video playback such as You Tube and Hulu, deliver video to users in the .flv format because of its fast download speeds and ability to be viewed at full-screen. The Flash Player plug-in is required to be installed in the browser to view any Flash content. Quicktime, AVI, and FLV formats can each be output from the majority of animation software that is available.

**Video Compression and Optimizing Playback Performance**

After a project is output or “rendered” as one of the specified file types, its data must be compressed into a smaller, more workable file size to ensure usability for the audience. This is especially true for web viewing where connection speeds and computer capabilities vary widely for a general audience. “Large files mean long download times and less efficient playback performance” (Krasner, 2004, p. 355). Because compressing a file also has the negative effect of reducing image quality, it is up to the designer to minimize this effect when it comes time to select the appropriate compression formula, known as the *codec*.

Codec selection is just the tip of the iceberg. As Dave LaRonde, Senior Promotion Producer for KCRG-TV (ABC) puts it, “making good-looking compressed files is almost as much an art as it is a science. It is not straightforward at all” (LaRonde, 2011). While compression can be done directly in the animation software, I found that
most professionals recommend the use of separate software (e.g., Sorenson Squeeze, Adobe Media Encore, or Apple’s Compressor) made specifically for video compression (LaRonde, 2010). Compression is a complicated element when working with digital video. It takes trial and error, as well as patience to get good end results (see Chapter III, *Outputting The Final Animation from Premiere Pro*).

**Video Dimensions**

The height and width measured in pixels determines the frame dimensions (frame resolution) of a video. The most common frame sizes today for video are NTSC DV, PAL, and HD. The NTSC standard is over 60 years old, but many changes have been made over the years in order to keep up with the advancements of display technology. NTSC DV is the standard most often used for DVD and broadcast output today in the United States (Krasner, 2004). Its pixel dimensions are 720x480 and can be set to full screen (4:3 aspect ratio) or widescreen (16:9 aspect ratio). PAL is the European standard used by over half of the countries in the world. Its pixel dimensions are 720x576 and can also be at full screen or widescreen format (Adobe, n.d.a; Krasner, 2004). While both NTSC and PAL have been the standard for decades, HD (High Definition) video is quickly becoming the new standard for film and broadcast. It comes in two different common frame dimensions; 1280x720 and 1920x1080, both of which are in widescreen format (16:9 aspect ratios). HD contains up to six times more pixels than NTSC DV or PAL which results in a much higher resolution and greater image quality.

As a multimedia designer working on a final project that is to be delivered in various formats, one should work at the highest frame dimensions of those deliverable formats. Similarly to print, motion graphics can always be scaled down without loss of
image quality. Conversely, increasing project pixel sizing from a smaller dimension will surely lead to loss of image quality and should be avoided whenever possible. So, why not work at the highest possible frame dimensions all of the time? Working at larger frame dimensions increases file sizes drastically, and can slow down production time as larger file sizes are much more taxing on computer hardware. It is up to the multimedia designer to plan accordingly, especially when working with a client (Braha & Byrne, 2011).

Frame Rates

Video is delivered to the viewer in sequential frames which play fast enough to create the illusion of moving imagery. The rate at which the frames are played is measured per second (frames per second). There are a variety of standard frame rates which should be followed when creating an animation. The frame rate should be determined based on what the desired playback device will be (e.g., broadcast television, HD, DVD, computer monitor, etc.) (Braha & Byrne, 2011; Krasner, 2004).

The frame rate for NTSC video is 29.97 frames per second (29.97p) and PAL is displayed at 25p. DVDs are created with frame rates of 23.97 but actually playback on televisions at 29.97p (Adobe, n.d.b; LaRonde, 2011). HD frame rates will work at the NTSC standard of 29.97p as well as 23.976p, 24p, 25p and 59.94p. The frame rate for true cinematic film is 24 frames per second. However, in the video world, 24p is actually 23.976p and there is a misconception about the term “24p” being used interchangeably. This can get confusing to say the least. 23.976p footage is more manageable to work with if it is necessary for an animator/video editor to have to convert to another frame rate such as NTSC 29.97p, which is very common especially when having to combine footage
created at various frame rates (Balis, 2007). Ideally, using source footage with matching frame rates in a single project will be much less troublesome but sometimes this cannot be avoided. For a movie title sequence animation being output to DVD or broadcast, 23.976p or 29.97p are both compatible frame rates to work with.
CHAPTER III

TREATMENT OF THE PROJECT

When approaching a complex animation, outlining the way in which the work will be conducted is almost as important as the work, itself (see Chapter II, *Tools and Methods for Creating an Animation, Production Pipeline*). The production pipeline created for and used in the production of the movie title sequence, *Beneath the Cherry Blossoms*, outlines the three main stages of production: pre-production (i.e., brainstorming, storyboarding, animatic), production (i.e., creation of art, animating), and post-production (i.e., editing and outputting) – as observed in the treatment of the animation (see Figure 1).

The pre-production portion of the treatment is meant to address the ideation process; it describes how my ideas were generated and the ways in which I processed these ideas into an organized and physical form. The production portion details my creation of imagery/artwork and the process of moving this imagery through space and time. (This section is particularly technical and includes software-specific information for various digital imaging and animating techniques). The post-production portion of this treatment details the final stages of polishing the work and preparing it for delivery to an audience.

The methods discussed below, performed for completion of this production, are to serve the multimedia designer as a reference guide. (Note: Software or methods
Figure 1. The production pipeline used for Beneath the Cherry Blossoms.
that proved ineffective or unsuccessful through trial-and error for the purposes of this production are discussed in Chapter IV: Reflections and Recommendations.

Pre-Production: Brainstorming

Defining Objectives and Finding Inspiration

Creating a title sequence for a non-existent movie is like writing a cover letter without a job description. In both scenarios, the latter provides crucial information in achieving a cohesive result. In the absence of such structure, I found that the standard queues for inspiration were lost and would need to be imagined or replaced. Initially, I concluded that although I would not need an actual film, I would need to decide on some of its relevant components (e.g., genre, setting, theme, etc.), in order to create a cohesive and engaging title sequence. At the same time I recognized that not having to worry about such details gave me total creative freedom to envision the artistic styles I wanted my work to embody, and realizing this oft-welcomed predicament proved both exciting and daunting.

Rather than completely reinvent the wheel, I began by revisiting my past projects to draw from previous experience while at the same time deciding on which areas of my work I might want to expand. For brainstorming purposes, I looked through the websites of various artists and animators who inspired me, as well as books and art magazines I had collected over the years. (Being a fan of a wide variety of artists, media and styles, I had compiled an extensive image library on my computer with all content meticulously organized in folders and named accordingly, so that I could reference a particular artist or preferred style at any given time.)
Outside of my academic work, I had also been doing side projects for small business owners, one of whom had requested a digital illustration and described a style that reminded me of my previous interest in Japanese sumi-e art. This led me to revisit my compilation of sumi-e related imagery and explore other forms of Asian art. I skinned through books I already owned on ancient Chinese brush painting, and thumbed through my collection of Japanese woodblock prints, calendars, and postcards. I took breaks in between to process ideas, (which coincidentally, usually involves time spent outside trimming and caring for my small collection of bonsai). By examining my own work and the work of others, maintaining an open mind, and allowing a process of continual brainstorming, I was able to find inspiration and more clearly define my objectives, which related to the visual style and rhythm I wished to achieve, and more naturally led to the mise en scène and other base elements of the film.

Gathering Reference Materials

Once I had a concept, my first order of business was to begin consolidating the bits and pieces of information that inspired me and to organize this reference material for easy access. As I sorted through the prints and pages of books, I began to scan and save the material that best fit my ideas. I also made copies of inspirational imagery I found online or already within my master reference library, and consolidated all files into a new folder within the master appropriately titled “Thesis Inspiration.”

Defining the Production Pipeline

I finally felt something tangible take shape as I imagined the other components of the film, and how I might want to animate its title sequence. I used words like romance and adventure to embody the feeling, while I imagined a female character
setting out on a long journey across Asia to find someone dear to her, encountering both joy and sorrow along the way. I realized that part of the appeal of sumi-e and Chinese brushstrokes was that these styles provided more “expressive” imagery, (not to mention, a vision for the setting and illustrations). This style seemed ideal for the purpose of creating a title sequence that would present only light imagery with free-flowing movements to build anticipation for my fictitious featured film.

Because I wished to incorporate traditional and digital paintings and illustrations of scenery, I decided to utilize the 2.5D technique (see Chapter II, *Current Motion Graphics: Advanced Animation Techniques, The CG Camera and the 2.5D Environment*). Additionally, my vision was to flow through the scenes with slow, sideways and forward sweeping camera movements to immerse the viewer in the scenes and give a sense that the artwork was coming to life. I knew that, in order to achieve this graceful transitional flow from one scene to the next, I would need to make good use of the CG camera (see Chapter III, *Moving the CG Camera through 2.5D Space*).

Once this was established, I could begin further defining my working production pipeline by mapping out all relevant tasks in a logical order. From a previous failed attempt to follow my production pipeline, I knew the importance of creating a timeline that would correspond to these tasks. I implemented the use of Google Calendar to document my projected goals and timelines, which would allow me to maintain better oversight of my production.
Pre-Production: Storyboarding and Animatic

Storyboarding

Once my production pipeline was complete, it was time to begin storyboarding. All visions and ideas were penciled out on scratch paper which included various notes, scribbles and small sketches. While these sketches could have been completed digitally, I chose to create my rough sketches in pencil for the simple reason that I did not have to be restricted to a computer desk to do so. The more details I roughed out in the beginning, the better off I would be when it came time for production.

Referencing my brainstorm notes and sketches, I sketched out scenes in sequential order within small squares on 11 x 8.5 inch paper. I also made a conscious effort to think about the organization of scenes as they would be organized within After Effects and Photoshop and made notes accordingly. I grouped scenes by making note of them with letters (A1, A2, B1, B2, etc.), respectively. These notes would eventually make up the naming convention for all digital files, which I could reference at any time by looking at my storyboards.

As I created the drawings, I was thinking about how the camera would not only frame the imagery, but also how it would move through the scenes. I made note of all camera movements with large arrows, along with short descriptors and notes explaining the movements, all of which I knew would be very helpful during production time. Aside from giving me a starting point from which to edit, saving these sketches as files on my computer ensured that I would be able to access them for easy reference at any time. In order to do this, I digitally scanned all four storyboard sheets, which I
decided to save as Photoshop files (PSD) at a minimum of 300dpi, and named each file according to their ordered page number. (See the completed storyboards in Appendix B.)

**Animatic**

Once I had a working storyboard in a digital format, I was ready to add a bit more detail and position the CG camera to capture the intended movement (angles, transitions, rhythm, timing, etc.) as noted on my storyboard. Since it incorporated both rough sketches and initial animation tests, it is hard to say when the “pre-production” stopped and the “production” began.

Since I was now dealing with multiple digital work files, I decided it was time to create some folders and naming conventions for organization and accessibility purposes. I first created a folder called “Work Files.” Within it, I created sub-folders for each scene (e.g., Part A, Part B, Part C, etc.). Now that I had a logical storage system for files, I could proceed to create the digital sketches that would be used in the animatic.

I opened the scanned storyboards in Photoshop and darkened the pencil sketches with a simple *curve* adjustment layer (Image > Adjustments > Curves). I created new documents for each scene, saved them out as PSD files with the file name corresponding to the scene, and placed them in their appropriate folders. Using my storyboard sketches as reference, I proceeded to sketch out the scenes in Photoshop. At this stage I was mostly trying to focus on layout of imagery, while visualizing how the CG camera would flow through the artwork. I gave careful consideration to how all objects in each scene would be grouped in the Photoshop layers panel as well. For example, if there was a cliff in the foreground, I made sure all pencil lines and paint strokes were done on that layer only. In doing so, it would make things much easier for
me once the artwork was imported into After Effects for the camera animation (see further details on working in Photoshop in *Production: Creation of the Artwork, Digital Drawing and Painting*).

Upon completion of the sketches of all scenes, I proceeded to import the PSD scene files into the After Effects project window to begin camera animation. It was important to fine-tune all camera movements in these early stages to really get a sense of timing. I first created a new composition (comp) for each scene and named them accordingly (see *Production: Animation Setup in After Effects, Importing Footage and Project Setup*). I meticulously arranged all PSD layers in their respective places within each comp and keyframed camera movements for all scenes. I continually referenced my storyboard notes for details on how and where the camera would move. I also roughed out the title placement with some placeholder text. It was very rewarding to finally see my storyboard sketches come to life as they began moving through time and space. (For further details on camera animation, see *Production: Moving a CG Camera through 2.5D Space*.)

**Production: Creation of the Artwork**

This section gives an overview of how all artwork was created for this project. Here, I will cover techniques used for the creation of both traditional and digital media. I will also give informative instruction on creating custom brushes and digitally painting in Adobe Photoshop, and Corel Painter, as well as how to add texture to the artwork.
Creating a Texture Library with Traditional Painting Techniques

I knew this animation project would be an ambitious one, and that I would have to call upon a multitude of skills and experiences I had picked up throughout my artistic career. It was very important to me that the artwork not seem overly digitized and maintained a traditional, paint on paper look. In the past, I had experimented with combining scanned artwork and altering it digitally in some of my personal illustration work. I wanted to apply this same technique to this animation.

The painting process began with heavily diluted Liquitex acrylic paint on Canson 140lb. watercolor paper. I coated the paper with light washes of random color with broad, spontaneous brush strokes mainly looking for interesting interactions, or “happy accidents,” between the paint and paper. I used black Winsor & Newton gouache and acrylic paint to create a series of dry brush strokes with a large, round brush. I tried to re-create the look of sumi-e calligraphy and brush painting as seen in my reference material, as best I could. I was not looking to create any particular shapes at this point, I just wanted texture. Once I had covered about five sheets of 9 x 12 inch watercolor paper with paint washes and brush strokes, I was satisfied with my work and was ready to make some paint splatters.

First, an old toothbrush was dipped into a small tray of diluted black India ink. I then fanned the bristles with a palette knife to spray the ink. I repeated the process until I had a nice variation of interesting ink splatters.

Once the painting process was complete, I scanned all work into the computer as JPEG files at 500dpi and saved into a folder so I could use them for texturing the
digital artwork later in production (see Adding Texture with Painted Washes and Custom Stamp Brushes).

Creating Custom Brushes in Photoshop

It was time to turn the best paint strokes into digital “stamp” brushes. I imported the scanned JPEG’s into Photoshop and turned them to grayscale (Image > Mode > Grayscale). I used the lasso tool to trace around a brush stroke to make a selection of it, then went to Edit > Define Brush Preset, and named it accordingly. I did this for each scanned brush stroke that I felt would make a good stamp brush. Once I had converted all the brush strokes into digital brushes, I went to the dropdown menu in the top right corner of the brush panel and selected “Save Brushes,” and named the new palette. Once saved, I could edit, add, delete, or re-arrange the brushes at any time. I now had custom brushes that could be stamped as any color, size or opacity that I wanted and they could also create some very real looking paint effects.

Digital Drawing and Painting

I used both Corel Painter and Adobe Photoshop to create the artwork used throughout the animation. I did so with the use of a Wacom Cintiq 21UX pen tablet. This unit allows me to draw with a stylus pen, directly onto the surface of a pressure sensitive monitor with exceptional accuracy. All artwork was saved as PSD files since these are easily transferable between both software applications as well as the animation software I would be using. Below is further instruction on the digital painting process applied throughout this project:

Setting Up Keyboard Shortcuts. Before I actually started creating the artwork, I spent a great deal of time setting keyboard shortcuts, as well as arranging my workspace
in both Photoshop and Painter, exactly to my liking. I also made sure to keep the shortcuts as similar as possible across software platforms (i.e., if the brush tool in Photoshop was set to “A” on the keyboard, then I made sure to apply the same in Painter). This way I could find the right tool when I needed it which greatly increased painting speed and efficiency.

**Project Settings.** In setting up all Photoshop and Painter documents for my artwork, I had to consider the many instances when the artwork would might have the camera zoomed in on it. It was important that imagery maintain high quality at all times and not have “blown out” pixels. Given that the animation would be at an HD resolution of 1920 x 1080 pixels, I created all artwork as PSD documents at a much higher resolution of 3840 x 2160 pixels.

**Customizing Brushes in Photoshop.** Photoshop comes packed with a variety of brushes. Over time, I had found the ones that best suited my needs and put them in a Custom Brush Palette called, *My Favorites*. This collection contained everything from dry texture brushes, to smooth flowing brushes as well as some basic essentials like a pencil, marker, and airbrush. The settings for any particular brush could be changed at any time by going to the Brush Settings menu and making adjustments as needed (see Figure 2). For every adjustment I made, the results could be seen in the brush preview window.

**Customizing Brushes in Painter.** Like Photoshop, Painter comes with an almost overwhelming number of digital brushes which are organized by the category of the media which they are meant to replicate (e.g., oils, pastels, watercolors, etc.). Painter makes it easy to create collections of custom brush palettes which can be arranged in any
order. By simply dragging a selected brush from the Brush Selector (top right of screen) into a vacant area within the application, Painter would automatically create a new brush palette window. This could be repeated as necessary, to fill the brush palette to my liking. The brushes could then be saved or renamed by going to, Window - Custom Palette >
Organizer > Rename. Any aspect of a selected brush could be edited at any time by going to, Window > Brush Controls > General, and making edits as necessary.

**Sketching and Drawing Digitally.** All sketches for this project were done in Photoshop because I found its editing capabilities to be much more efficient than those of Painter’s. Using my storyboard as reference, I began each scene with a rough sketch using a pencil brush and a light blue color selected. I then did a second pass over the sketches with black, to define the imagery more. While sketching, I was continually using the undo command (Ctrl+z) as well as my eraser tool to get rid of unwanted line work. While the drawings were rough and I was trying to work efficiently without getting caught up in too much detail, I had to take time to make sure I was always painting on the intended layer and that they were named appropriately for organizational purposes.

**Painting in Photoshop.** When painting in Photoshop, I would select a desired brush from the brush menu in the top right of the screen, along with the desired color in the color palette and proceed to paint over my sketches. I mainly used brushes from the Dry Media, and Wet Media palette, but this varied throughout the work. I found that I was most comfortable filling in sketches with a mid-tone, then applying lighter and darker values to add detail. I needed to be careful that I was painting on the correct layer at any given time. All of which I meticulously named and arranged in an organized fashion as they were created. For instance, if I was painting over the layer “Cliff_1,” I would make sure that I had that layer selected in the layers panel. Not doing so would lead to having to undo my work. With the amount of digital painting I needed to do and the large number of layers there were, this became a tedious task.
Once I had applied some color, it could be blended together smoothly with a technique I had learned years previous from a book called *Digital Character Painting Using Photoshop CS3* by Don Seegmiller. To perform this blending technique, I would lay down a base color with full opacity. Then, I would paint a second color in the vicinity of the first base color until I was eventually painting lightly into it to create a combination of the two colors or a “middle-ground” color. With the eyedropper tool (in the Tools panel), I sampled the middle-ground color and began painting lightly with this new color. Finally, a soft blend would start to develop. This took some practice but it gets the job done in Photoshop versions CS4 and below. With the latest release of Photoshop CS5, Adobe incorporated a blender brush. I found that it works fairly well however, the method of blending color mentioned above is the way I am most adapted to.

**Painting in Painter.** I used Painter to add a variation of brush work and texture to my Photoshop illustrations. PSD files could be directly opened in Painter and exported, without having to perform any file conversion. Once a PSD was opened, I looked for areas of the artwork that I thought would benefit from a touch up with some of my Painter brushes. Just the same as when in Photoshop, I had to be conscious that I was painting within the intended layer whenever I touched my stylus pen to the screen to paint. Colors blend much easier in Painter than Photoshop, but I wanted to be careful not to blend too smoothly as this would lose the texture that I wanted to maintain.

While painting, I was always doing so with a paper texture selected. Paper textures could be easily implemented by going to, Window > Library Palettes > Papers, and making a selection. I always had this window open so that I could make adjustments
to textures as I painted. For the purpose of this animation, “Italian Watercolor Paper” and “Thick Handmade Paper” became two of my favorites.

Adding Painted Washes and Custom Stamp Brushes for Texture

Previously, I had scanned all paint washes and brush strokes and placed them in a folder. The first image in Figure 3 shows one of the paint washes after it was scanned. Once a rough sketch of each scene was complete, I was ready to again access these scanned images and apply them to the digital artwork. I would first select a paint wash which I thought would best suit the area I was adding the texture to, and import it into the Photoshop document (see Figure 3, Image 2). The image would automatically become its own layer and I made sure that it was directly above the layer which it would soon be applied to. It was then turned to black and white (Image > Adjustments > Black & White).

At this point the paint wash was covering up the digital artwork below it. To remedy this, I applied a clipping mask by right clicking on it in the layers panel and choosing “Create Clipping Mask.” This would apply a “cookie-cutter” effect, which cut-out the paint wash layer so that it was only revealed within the boundaries of the layer directly below it (see Figure 3, Image 3). I would then adjust the blend mode in the top of the layers panel, to a setting that best fit with the particular layer which I was applying the wash to. This would help blend the wash with the digital artwork by taking on the colors of the layer below it so that it looked natural. Most often, I found the “Multiply” or “Color Burn” settings worked best, but the only way to know for sure was to use a guess and check method. Once the blend mode was set, I would lower the opacity setting (top-
right of the layers panel) of the paint wash layer to a setting of 60 to 80 percent to make it less overpowering. Once in place, I would apply color to the layer to finish the artwork (see Figure 3, Image 4).

The custom stamp brushes that I had previously created in Photoshop were also implemented at these final texturing stages. I accessed the brushes by going to the dropdown menu in the top right corner of the brush panel and selecting “Load Brushes,” and browsing to where I had saved my stamp brushes. They would then be visible in the brush panel with a preview of each brush. Once one was selected, I could choose a color and opacity and stamp the paint stroke on any given layer to add even more realistic paint

Figure 3. An image series showing the process of combining traditional and digital media.
texture. Once all scenes were painted and textured and I felt satisfied with the results, it was safe to call the artwork complete.

Production: Animation Setup in After Effects

Importing Footage and Project Setup

Now that I had created some artwork it was time to setup the project for animation inside of After Effects. I began by importing the PSD files by going to File > Import File and browsing to the desired directory which contained the PSD scene files. Once a Photoshop file was selected, After Effects would ask how I would like to import the file. I chose “Composition - Retain Layer Sizes.” This selection imports all layers within the Photoshop file at one time and automatically placed them in a single file located inside the project panel. Additionally, After Effects creates a new composition with the same name as the PSD file and places it in the project panel as well. Double clicking on the new composition in the project panel would import all of its assets into the timeline panel in the same order they were arranged in Photoshop, which was very helpful (Figure 4 shows how workspace panels are arranged inside After Effects. Within the timeline are a series of PSD layers).

Once assets were imported into the timeline for a scene, I edited the composition settings by going to, Composition > Composition Settings. Here, I could choose the size, length and frame rate of the comp. Each composition was setup at HDTV 1920 x 1080 (1080p) at 23.976 frames per second and square pixels (see Figure 5). The duration was set according to my estimated guess of how long a particular scene might
Figure 4. The Adobe After Effects workspace.

be. Any of the settings, including the duration of a comp could be changed at any time by returning to the Composition Settings window.

Arranging Footage in a Composition

Once the project settings were adjusted and all footage was imported, it was time to arrange the PSD layers within each composition. I like to think of this part of the production process as assembling a movie set or stage with the different layers of artwork representing the props and scenery.
To begin this process I first opened the intended composition (double-clicking on the comp in the project window). Once opened, all PSD layers would be arranged in the timeline panel and also visible inside the composition panel. While layers were organized and named the same as when I created them in Photoshop, the composition was much too large at this stage since I had created the artwork at a resolution of 3840 x 2160 pixels. I would need to get all footage within a 1920 x 1080 screen area.
To do so I selected and copied (Ctrl+c) all layers in the timeline. I created a new comp at HD 1080p and pasted all layers in its timeline panel. At this point the artwork stretched far beyond the viewable screen area. To remedy this, I created a new camera. In order for all footage to be affected by the camera, I turned them into 3D layers (see Figure 6). By doing so, I had the ability to move the footage on the X-, Y-, and Z-axis.

![Figure 6. PSD layers arranged within the timeline panel, with the camera zoom property and 3D toggle buttons highlighted.](image)

within the composition workspace. Next, I went to the Camera Options dropdown menu within the timeline and adjusted its zoom property until all footage fit within the viewable screen area. I was then ready to adjust the distance that each layer was from the camera.
by editing their properties on the Z axis, individually. To do this, I moved footage that was intended to be in the background, further away from the camera and footage that was intended to be more in the foreground, closer. While arranging artwork within a scene, I used the many viewing options available in the composition panel which made it much easier to place imagery exactly where I wanted it (see Production: Moving a CG Camera through 2.5D Space, Changing Views in the Composition Panel, in this chapter). Once footage was arranged within its respective scene, it was ready for camera animation.

“Nesting” Compositions

I now had a series of compositions, each containing arranged assets that made up a scene. Each composition had a title for the scene which it represented (e.g., A_Fly-in, B_River, etc.). Each of these compositions was essentially a “mini” project that could be worked on independently. Eventually, they would all be placed inside of a single composition which would make up the final animation. This technique of placing compositions within each other is known as “nesting.” When working on large projects, nesting is essential to make for much easier organization, accessibility and editing of all assets.

Once each scene was fully animated with all camera movements, it was dropped into a single comp which I named “Main Movie.” Main Movie would eventually contain all compositions for this project (see Figure 7). Additionally, it would also have its own animated CG camera which would bring all elements together (see Production: Moving a CG Camera through 2.5D Space, Tying All Compositions Together with the Final Camera).
When a composition is placed inside of another comp, it shows up in the timeline as a single layer even though it may contain a large number of assets. It also has its own properties such as position, scale, and opacity which can all be keyframed. When any of these properties are edited, all assets contained within it are affected as a single group which gives the designer a lot more options with how footage can be animated.

Figure 7 shows an example of the nested compositions in my project. In the figure, the “Main Movie” contains all of the scenes which are broken up into their own compositions. Within each scene are the PSD layers which make up the imagery. Here you can see the “clouds.psd” layers that are within the “Part_A_Fly-in” composition.

Production: Moving a CG Camera Through 2.5D Space

Setting Up the Sure Target Plug-in and Null Objects

In order to create more advanced camera animations efficiently, I used a camera plug-in called Sure Target. (This plug-in and many others can be downloaded for free from Video Copilot’s website at, www.videocopilot.com.) To begin camera animation for a composition with Sure Target, I needed to create a new Null object layer. Think of a Null object as an invisible handle that can be attached (parented) to objects or layers to give the multimedia designer more options and flexibility for the movement of the object which the Null is attached to. When viewed in the Composition view panel, Nulls appear as red outlined rectangles with anchor points, though they will not show up once the final project is rendered. With regard to a Null object being used with a CG camera, any change in properties applied to the Null will directly affect the movement of
Figure 7. The composition flowchart within After Effects.
the camera. I appropriately named the Null “Sure Target Null” to help me identify it in the timeline panel. Once the Null was named, I selected it in the timeline and implemented the Sure Target plug-in (Effects > Video Copilot > Sure Target). Doing so would automatically place a new camera layer in the timeline titled “Sure Target Camera,” which was directly connected (parented) to the Null layer. Now I could edit a number of various properties of the Null which would directly affect the movement of the camera. This would be the method for moving cameras through scenes throughout the project.

**Creating Camera Targets**

With sure target implemented, the camera could be directly targeted to any PSD layer I wanted. Additionally, I had the option of creating my own targets with the use of other Null objects which could be added anywhere within a scene. I found this method most useful throughout the camera animation process. To create a point for the camera to target, I made another Null object and named it as whichever target it corresponded to (e.g., Target 1, Target 2, etc.). I immediately turned it into a 3D object by activating the 3D button in the timeline. Doing so made it possible to move the Null object along a Z-axis in 3-dimensional space. I moved the Null to a position that I wanted to target within the scene.

I needed to tell Sure Target what order to target each Null. This was done inside of the Effects Control panel which can be scrolled to in place of the Project panel to the left of the screen. When viewing the Sure Target controls, there is a list of targets under the dropdown for “Target Layers.” To the right of each target number there is a dropdown menu. I selected the Null object in the dropdown so the target number and Null
object matched each other. For example, “Target 1” in the list corresponded with the
“Target 1” Null object in the dropdown menu. “Target 2” corresponded with the “Target
2” Null object etc. (see Figure 8).

![The sure target effects control panel.](image)

*Figure 8. The sure target effects control panel.*

**Keyframing Camera Targets**

Once target Nulls were in place, it was time to animate the camera to their
location. This was done in the timeline panel under the dropdown menu of the Sure
Target Null layer. (For the purpose of this example, use Figure 9 for reference.)
Figure 9. The timeline panel with keyframed targets in place. Highlighted on the left, is the sure target stopwatch and input for keyframing target numbers.
Activating the stopwatch icon and typing in “1.00” would specify the first target number that the camera would move to. In the instance of this example, this would give the camera a starting point (“A”). Scrolling down the timeline and clicking the keyframe button would place a second keyframe (“B”), which would create a camera hold on this first target. Moving down the timeline and typing “2.00,” would keyframe the starting point for Target 2 (“C”), thereby creating camera movement from one target to another (in this case, movement from “Target 1” to “Target 2”). I could create another keyframe by moving down the timeline a few more seconds and clicking the keyframe button once again (“D”) which would become Target 2’s holding point. I repeated this process until all of my targets for a particular scene were keyframed.

At this time I was not concerned with how far apart the key-frames were, I just wanted to key in each of the targets. It is very easy to change the speed in which the camera traveled from target to target by moving keyframes either closer (sped up camera movement) or further apart (slowed down camera movement). Once targets were keyframed, I could do a RAM Preview (Composition > Preview > RAM Preview) to generate a preview of the camera movements in real-time. If the timing was not to my liking, I made adjustments to the spacing of the keyframes. For example, if I had a camera hold at a target that was too long, I simply moved the keyframes closer together to shorten the time that the camera was holding at a position. Once targets were arranged and keyframed, I had the basic camera movements, but they would still need further fine tuning (see Production: Applying Advanced Animation Techniques, The Graph Editor, below).
Once all camera movements were completed for each individual scene/comp, it was time to bring those scenes together so they would play in sequential order. Previously, I had discussed nesting all comps within a single comp named Main Movie. Once the Main Movie was opened and viewed in the Composition panel, the nested comps within it appeared as a stack of overlapping scenes all playing back at the same time. In the timeline panel, each comp was represented by a single layer. As stated earlier, any adjustments or movements made to one of the compositions would affect all the layers and assets within the comp. Therefore, it was possible to move entire scenes into new positions on the X and Y-axis throughout the Main Movie comp. By arranging the scene/comps sequentially in the Composition panel, I would be able to implement a “Master” camera which could be animated to the position of each scene/comp, thereby tying all scenes together for the final animation.

To begin the process of arranging the Main Movie comp into a final playable state, I positioned each scene comp in close proximity to its neighbor so there was no overlapping inside the Composition panel. I also placed them in the subsequent order and positions that the camera would move to them. For example, since I wanted the camera to exit the Part A comp from the bottom and enter the Part B comp from the top, I placed Part B below Part A on the Y-axis.

After the scenes were in position, they were still all playing back at the same time. I offset the timing of each comp by sliding them down the timeline so that when one played out its scene, another would begin, and so on (see Figure 10).
Figure 10. The final compositions within the main movie timeline.
When scenes were finally in place and timed correctly, I was ready to add the Master camera which would be animated to each scene’s position. The movements of the camera from composition to composition would create the flowing transitions from each scene to the next.

I applied Sure Target to the Master camera, the same way as discussed above with PSD layers. At this stage however, the compositions themselves became the targets (i.e., Target 1 was Part A, Target 2 was Part B, etc.) Targets were keyframed in Sure Target so that the camera would travel to a targeted scene and hold long enough for that scene to play out. Then the camera was keyframed to the next scene until the entire Main Movie composition played as a single seamless animation.

Once complete I needed some kind of background in the Main Movie so there wasn’t just white space. Previously, I had created a large image that was painted and textured in Photoshop to use as the backdrop for my animation. It was very large at 7680 x 4320 pixels and extended far beyond the viewable screen area. However, this was needed given that it would be the furthest object from the camera and needed to still retain the entire screen area. I dropped it into the Main Movie comp, turned it into a 3D layer and moved it into position on the Z-axis. At last, this animation was beginning to take shape!

Additional Features in Sure Target

Sure Target has a number of additional properties that can be keyframed to add more dimension and versatility to camera movements. Some of those techniques are listed below with a description of what they do, and how they were used for this project:
- **Auto-Focus.** I used auto-focus to create the depth-of-field effects which made it so that objects not in the focal range of the camera would appear blurry. This adds a more natural feel as objects too close or far away to the viewer would not be as clear and detailed. Auto-focus is adjusted with the Aperture and Blur Level settings.

- **Dolly:** A separate dolly was setup for each individual target. Once a dolly is keyframed in the timeline, its properties can be changed to zoom in and out of a target.

- **Adjusting Camera Framing with the Pan Behind Tool:** The pan behind tool is generally used to move an anchor point of a layer. When used on a Sure Target Null object, it will move the camera on the X and Y-axis, which gives a lot of flexibility to how/where the camera, frames a scene. To make adjustments, I would select a layer that I wanted to pan around. Then, with the Pan Behind tool selected, I could click and move the anchor point of the selected layer inside the Composition panel and the result was the camera moving on the X and Y-axis. The movement applied would make adjustments to the Anchor Point and Position settings of the particular Null object layer.

- **Camera Tilt:** For even more camera control, the Sure Target Camera layer can be keyframed at the X, Y or Z Rotation positions to create camera tilts. I used this function whenever I needed the camera to roll or “bank” as it was making a turn. This added a more realistic “drift” effect to the camera movements.

**Changing Views in the Composition Panel**

While performing all camera movements, it was essential that I could see the environment I was working in from all angles. Within the Composition panel, under the View dropdown menus I could change the views of the scene. I mainly worked with two horizontal views. One was always set to “Active Camera” so I could see what the camera
was framing at all times. The second view was adjusted as needed to make it easier for me to select and arrange footage within the scene, or make necessary camera adjustments with more flexibility (see Figure 11).

Production: Applying Advanced Animation Techniques

The Graph Editor

Once the basic movement of the camera was keyframed with Sure Target, I had a pretty good idea of how the timing of the animation was going to be. It was then time to begin smoothing out the camera movements. This process involved many advanced techniques and was primarily done by editing the keyframes inside of the Graph Editor.

One of the most common problems that I needed to fix were the jerky, uneven movements of the camera as it moved into and out of targets. What I wanted were very smooth movements where the camera was able to slowly ease into a position, hold briefly, then ease out of that position and move to the next shot. This process of “easing” keyframe velocity can be done by right-clicking a keyframe and selecting Keyframe Assistant > Easy Ease In/Out, respectively. While this process worked in many situations, there were instances when I needed much more detailed control over the keyframe velocity. To do this I used the Graph Editor. There, I could see a detailed graph that showed me the speed at which the camera was moving as it traveled from each keyframe.

To view keyframes I wanted to edit in the Graph Editor, I simply highlighted the target keyframes, and clicked the graph editor button (see Figure 12). Inside the
Figure 11. The composition panel displaying two horizontal views of the project.
Figure 12. The graph editor before keyframes were adjusted with Bézier curves.

timeline panel, I could then see the speed at which my selected keyframes were moving and make any appropriate edits.

Interpreting the graph, the higher the line goes, the faster the movement of the object, or in this case the camera movement. The lower the line goes, the slower the movement. In order to make appropriate adjustments, I had to make sure none of the movements were linear, which appear as straight lines in the graph. With linear movement, there is no speed change between keyframes, so objects move from each point at a constant speed, hence the reason for jerky camera movements. The only time I did want linear lines was when the camera was completely still, or holding. For this animation, I needed to smooth out some of the linear movements so that they were on “eases” represented by curves in the Graph Editor. A quick way to change the linear keyframes is to use the “Auto Bezier” button located at the bottom-right of the graph editor. To do this, I would select the target keyframe(s) and click the auto Bézier button and the keyframe would change to a Bézier curve, resembling an inclining or declining
hill with handles that could be used to adjust the curves. Figures 12 and 13 show an example of the graph editor before and after Bezier curves were added.

![Graph editor with Bezier curves](image)

Figure 13. The graph editor after keyframes were adjusted with Bezier curves.

After long hours spent smoothing out camera movements, I got into the habit of applying a guess and check technique by first adjusting the curve and then either scrolling (scrubbing) through the playback or doing a RAM preview (Numpad+0) to see the effect of the alterations in real-time. Additional adjustments to the Graph Editor were then made, if needed, until the camera movement was exactly the way I wanted it.

Keyframing with the Puppet Tool

Numerous objects were animated in After Effects using the puppet tool, located in the top-right of the Tools panel. I used this tool whenever I wanted one of my images to bend or deform. For instance, applying the puppet tool to a PSD layer representing tall grass, allowed me to manipulate it in ways that made it look as if it were swaying in the wind.
This was done by placing “pins” on the specific areas of an image that I wanted to have movement. Once a pin was in place, it acted as a joint which could be manipulated and keyframed over time. Pins were keyframed in the dropdown menu under the Puppet effect in the timeline (Puppet > Mesh > Deform > Puppet Pin).

**Keyframing a Butterfly with “Expressions”**

In one of my scenes, I wanted a butterfly to flutter into one of the camera pans. I had seen this done in other animations, but had never attempted it. This process would involve nesting compositions, and some advanced keyframing techniques using Expressions.

Before animation began, I created a butterfly in Photoshop that was made up of three different layers—the body and the left and right wings—all named accordingly. I imported the footage into my main project in After Effects and created a new composition, just for the butterfly. Once my footage was in the timeline, I made each layer 3D by clicking the 3D toggle button. My comp was set and I was ready to begin animating the wing flaps.

For almost the entire production I had been using keyframes to animate objects. Another way to move imagery inside After Effects is by using “Expressions.” This involves telling After Effects how and where to move footage with the use of some coding. Expressions would be very helpful and save me a lot of time in animating a wing flap for the butterfly.

To begin the process, I added a Null object named “Wing Controller” and added a Slider Control effect to it by going to Effect > Expression Control > Slider Control (top-left of Figure 14). This Slider property would soon become the main
Figure 14. A view of the timeline panel for the butterfly composition.
controller for the wing flap so I named it “Wing Flap,” accordingly. Then, I Alt-clicked the stopwatch button in the Timeline panel for the Y-Rotation properties of each wing to open the Expressions options. I selected the Pick Whip (small swirl icon) for each Expression property and dragged the selector to target the Slider effect under the Null object (see Figure 14). After doing this, After Effects automatically implemented a bunch of code in the timeline for each Expression property. At the end of the string of code for the Wing_Left layer, I simply typed in “* (-1),” (far-right of Figure 14) which made it so that when I changed the properties on the Wing Flap slider, both wings rotated up and down on the Y-axis. I keyframed this property so that the wings moved up and down with a slight change in speed to add variation. The keyframes were then smoothed out with Bézier curves inside the Graph Editor.

When the wing flaps were complete, I dropped the Butterfly comp inside of the appropriate scene/comp and keyframed it along a zigzagged motion path. I then selected the Butterfly comp in the layers panel and went to Layer > Transform > Auto-Orient > Orient Along Path. This automatically made the butterfly face in the direction it was moving along the path, and made its flight look more natural. Once some slight adjustments were made to smooth out movements inside the Graph Editor, the animated butterfly was complete and brought much more life to the scene. (For an introductory video tutorial to learn how to animate with Expressions go to the AE Portal at http://aeportal.blogspot.com/2010/02/butterfly-animation-in-after-effects.html.)
For one of the scenes, I wanted to have a fish swim across a slow camera pan. The keyframing tools in After Effects would not suffice for the smooth, flowing motion that I wanted to create. I would need to implement the traditional frame-by-frame animation method inside digital software. For this task, I used TV Paint (TVP) animation software to manually draw in the motion of the fish, one frame at a time. I then brought the rough animation into Photoshop so that it could be finalized and colored, again, one painstaking frame at a time. Once completed, the animation was brought into After Effects and incorporated into the main animation. This process involved rendering the sequence multiple times from different software. While doing so, I needed to be conscious to maintain the alpha channel for the imagery. An alpha channel is the data that stores transparency information for an image. Rendering with alpha data intact would ensure that my imagery would not have a background and could be placed over, or within, another source (i.e., After Effects) without covering up the underlying imagery of that source. This end result of combining the imagery from different sources is a technique known as “compositing” imagery. Below is a detailed outline of how the image sequence for the fish scene was created and composited into After Effects.

Creating the Frame-by Frame Animation in TV Paint

I was able to import the original sketch of the fish and lily pad scene that I had previously done in Photoshop, directly into TVP. Once imported, I needed to adjust the frame rate before I could begin animating. I went to Project > Modify Project and set the Frame Rate to “12.00” and clicked “Modify.” Upon viewing the timeline (see Figure 15),
I could see that the PSD file retained all of its layers within TVP, which was very helpful. Layers can be used within TVP in a very similar fashion to Photoshop and Corel Painter. The added benefit is that layers can be broken up into frames that can be drawn or painted individually to create frame-by-frame animations. Like After Effects, TVP has a timeline that can be navigated through, to view the movement of the artwork through time. One of the most helpful features in TVP is the Light Table. This panel allows the user to see artwork in multiple frames at once. While drawing out the movements of the fish, I used the Light Table to see the drawing I had made from the
previous frame and when necessary the drawing after my current frame. This provided me with a reference point to work from so I knew where to draw when I was on a new blank frame.

For instance, Figure 15 shows the TVP work area with three frames turned on. These are my “key” drawings also referred to in the frame-by-frame method as a “keyframe,” hence where the term derived from in the digital world. From this point I would want to create the next drawing between the blue and the green fish. This would be the “in-between” frame which fills in the movement of the key drawings. In-betweening cannot be accomplished without a reference point or in this case, the Light Table tool. The process of manually drawing in key drawings and then in-betweening was repeated in TVP until I had smooth movements of the fish swimming out from under the lily pads.

Once completed, I needed to export the series of drawings into a sequence of images that could be imported into Photoshop for painting. Eventually, the finished sequence would be brought into the main animation in After Effects. (For more information on animating in TV Paint, visit http://www.tvpaint.com.)

Exporting the Image Sequence from TV Paint

Before exporting, I created a destination folder to save the image sequence to. Then, in TVP I went to File > Export Project To. Inside the Export Footage window (see Figure 16), under the Format dropdown menu I selected “PNG.” In the Mode dropdown menu I chose “RGBA 32bits.” For the Alpha setting I selected “PreMultiply.” These selections would maintain the alpha channel data for each image in the sequence, which was important. Since this image sequence was made up of sketches and was not the final artwork, it was all right to apply a bit of compression. So, I left the default Compression
setting at “5.” Next, I made sure to browse to the destination folder I had created and I check-marked the “Sequence” box so TVP would render out all of the frames. I double checked the size, frame rate, and aspect ratio settings and left them alone. I was ready to render and clicked the “Export” button.
Painting the Image Sequence in Photoshop

It was time to import the image sequence into Photoshop so I could begin the painting process. When I browsed to the folder that contained the PNG’s and selected one to import, I made sure to checkmark the box that said “Image Sequence.” A box automatically appeared asking what frame rate I wanted the footage interpreted as and I input “12.” Photoshop placed the image sequence in a “video layer” within the layers panel and I named it “Sketch.” In order to view each frame so that I could begin painting on them, I opened the Animation panel (Window > Animation). This panel has a basic timeline within it that could be scrolled through one frame at a time with the arrow keys. Clicking the play button or spacebar, would playback the animation in real-time. Now that I had frames I could begin painting in them.

I did not want to paint over the PNG sequence, so I locked it in the layers panel. Then, I created a new video layer (Layer > Video Layers > New blank Video Layer) and set it below the Sketch layer so I could paint in the color for this animation. Using the sketch layer as a guide, I meticulously painted in each frame, one at a time using similar methods as previously discussed in Creation of the Artwork, Digital Drawing and Painting. The only difference was the fact that I was navigating through individual frames to paint on, instead of a single static image. After all frames had been painted, I was ready to export this sequence.

Exporting the Image Sequence from Photoshop

First, I created a new folder to have the painted PNG sequence exported to. Then I went to File > Export > Render Video to open the render options (see Figure 17).
There, I set the destination folder and named my image sequence appropriately. Under the File options I clicked the “Image Sequence” button and set the dropdown menu to “PNG.” Under the Render Options next to Alpha Channel, I made sure to select “Straight-Unmatted” in the dropdown menu which would again ensure that no background was rendered with this sequence. I double-checked that size was 1920 x 1080 and Frame Rate was at 12fps and clicked “Render.” The render process only took a couple of minutes, since I wasn’t dealing with very complex imagery or effects. Once complete, the finished PNG sequence was ready to be brought into After Effects to be combined with the rest of the animation.
Compositing the Image Sequence in After Effects

To import the PNG image sequence into After Effects, I double-clicked inside the project panel and browsed to the folder containing the sequence I had rendered from Photoshop. I selected one of the images in the folder and check-marked the “sequence” box. After Effects would now treat this footage the same as a video. The most important order of business when importing sequences or video footage is to make sure that the footage is either matched to the project settings or is at least compatible with it. The frame size of the sequence matched the 1080p resolution of the project. However, my main project was set to 23.976 frames-per-second while my PNG sequence was at 12 frames-per-second. The PNG footage needed to be “interpreted” so that it would play correctly when dropped into the timeline of a composition. This was done by right-clicking the PNG sequence in the project panel and going to Interpret Footage > Main. Once the Interpret Footage window opened, I went down to the Frame Rate setting and typed “23.976/2.” Once I hit Enter, After Effects divided 23.976 by 2, leaving “11.988” inside the frames-per-second field (see Figure 18), which was what I wanted.

Figure 18. The frame rate interpretation for the PNG image sequence in After Effects.
Now that everything was interpreted correctly, I could finally place the footage into its respective scene. Once positioned, the sequence played back correctly in the main project as After Effects automatically doubled each frame to fit the 23.976 frame rate. This was a long process and involved three different programs to reach the end result, but it was well worth the effort.

Production: End Details and Effects

**Applying a Ripple Effect**

After spending a significant amount of time creating and successfully compositing the frame-by-frame fish animation, it needed one last finishing touch to complete the scene. I decided to enhance the environment by adding a “ripple” effect. Unlike many effects, this one is relatively straight-forward to apply. By going to Effect > Distort > Ripple, I was able to manipulate the Wave settings to produce and control some very realistic-looking water ripples. Once this effect was added, the fish actually looked as though it was under water and my scene was complete.

**Creating Custom Ink Bleed Effects**

For transitional effects, I wanted all the artwork for this animation to look as if was flowing onto the screen like a live painting or an ink bleed. I did this by creating a series of “ink bleed” animations that were created with a combination of effects in a separate After Effects document. Later, these animations were individually incorporated into the main project and used as masks to gradually reveal the artwork beneath it, simulating the action of a “paint on paper” effect. Below is detailed instruction on how this was done:
Applying Effects to Create a Bleed Animation. Essentially, these simulated ink bleeds were simple white rectangles with a variety of effects applied to them which gave them the silhouette appearance of runny ink. To create this effect, I first created a new composition at 1280 x 720 and 23.976 frames-per-second. I then created a white solid rectangle by going to Layer > New > Solid. I wanted the bleed to begin as black and have the rectangle slowly reveal itself until it filled the frame with white. Do to so, I applied either a Radial Wipe (Effect > Transition > Radial Wipe) or a Linear Wipe (Effect > Transition > Linear Wipe) depending on whether I wanted the effect to reveal from one side to the other (linear) or from the center outward (radial). Once this effect was keyframed so that it took place over a period of three to four seconds, I was ready to add effects to simulate the runny ink. I applied Roughen Edges (Effect > Stylize > Roughen Edges) which does exactly what the name implies. By adjusting the Fractal Influence and Border settings within the effect, I could change the intensity of the rough edges. These settings were both keyframed so that their properties had slight variation over time. This process was repeated until I had a variety of very different bleed effects (see Figure 19).

Reversing the Animations to Create Variation. By reversing the animations, I created a variety of different bleeds without much work. I began by inverting the bleed by going to Effect > Channel > Invert. This would turn black pixels into white and white pixels into black. Next, I went to Time > Time-Reverse Layer. This flipped the animation to play in reverse so that it started with black and ended with white as before. With just a couple of quick selections, the animation could be turned inside-out to create completely different looking bleed effects.
Figure 19. An example of an ink bleed mask being revealed over time.

Turning Ink Bleed Animations Into Masks. Once I had about fifteen different effects that were each unique, I rendered them individually as uncompressed Quicktime videos. (For details on rendering Quicktime video, see Rendering from After Effects, below). Once rendered, these ink bleed videos were all placed in a folder within my project files, and then imported into the Project panel so they could be easily dropped into any composition.

In order to turn one of the ink bleed videos into a mask that would slowly reveal artwork, it was placed directly above a targeted PSD layer in the Timeline panel. The next step was to turn the Quicktime ink bleed into a 3D layer and place it at the same position within the composition, as the targeted PSD layer it would mask. Once in position, I set the Track Matte dropdown menu for the PSD layer, to “Luma Matte” in the
Timeline panel (see Figure 20). This makes it so all black areas of the layer above, which in this case is the ink bleed video, will mask the artwork while all white areas reveal it.

Figure 20. A close-up view of the timeline panel. Here, a luma matte has been applied to the PSD layer “Bamboo_5.”

As the Quicktime ink bleed video plays out, it gradually un-masks the artwork, thereby simulating the runny ink effect I was intending (see Figure 21). Sometimes when applied, I discovered that the mask had too hard of an edge which looked overly digitized. To remedy this I applied one of two methods. I could apply a Gaussian Blur by going to Effect > Blur & Sharpen > Gaussian Blur and adjusting the Blur setting appropriately. The other method was to significantly increase the scale of the bleed which would blow up the pixels and soften the edges.

Time Remapping an Ink Bleed. I could adjust the timing of the ink bleed by selecting it and going to Layer > Time > Enable Time Remapping. This would automatically set one keyframe at the starting point and a second at the ending point of the video in the Timeline Panel. Sliding the second keyframe to the left in the Timeline panel would slow down the animation while sliding it to the right would speed it up accordingly. The process of arranging the ink bleeds and timing them was repeated until nearly all the artwork had the effect applied. While time consuming, this process was necessary to create the live painting effect that I wanted throughout my title sequence.
Incorporating the Movie Titles

I had begun planning where the titles were going to be placed as early on as the storyboarding stage. I not only had to think about where titles would be incorporated within the imagery, but at what point in time. I could not really get a good sense of how the titles would look until most of the graphic elements and camera movements had been completed.

Since the imagery was going to be the main focus of this title sequence, I didn’t want to draw too much attention to the titles with elaborate animations, effects or color. I wanted them to be fairly subtle, while still being part of the scene.

Once scenes and camera movements started coming together, I would use the Type tool to place a title within its respective scene, and then move it into an area within

Figure 21. The results of an ink bleed mask applied to PSD layers.
the frame I thought it would fit. At this point I was just using the “Times New Roman”
typeface with placeholder text that read, “Movie Title.” Later, I decided on how to
arrange the names and what they would be, considering they were fictitious.

When I had initially placed the titles, I had them follow along with the
camera, pinned within the viewing area at all times. After some deliberation, I decided I
wanted the titles to react more to the movement of the camera rather than float along with
it, just as all other graphical imagery did throughout the animation. This was
accomplished by turning type layers into 3D. Once this was done they could be adjusted
on the Z-axis, so I had to place each at a sufficient distance away from the camera. I was
careful that titles were not too large and overwhelming, or too small and illegible. As 3D
layers, the titles acted more as graphical elements than type. As the camera panned across
a shot, the title would drift along with the scene and other imagery around it, which
created the effect that I was looking for.

Once the titles were moving within the scenes the way I wanted, I looked at
different typeface possibilities. I input various options into the scenes and did a RAM
preview to see how they looked upon playback. I did not make a decision immediately,
and instead, continued to implement various typeface selections as the animation
developed. After a process of elimination I decided on a typeface called “Nyala,” which
seemed to fit the theme I was trying to achieve. The sharp serifs of this typeface seemed
to have a subtle resemblance to Chinese and Japanese calligraphy and pointed tips of the
brush strokes I had observed in my reference material.

Once the titles were replaced with my typeface selection, I applied the ink
bleed masks using the same process mentioned previously for other graphical imagery.
Once a mask was in place, I used the Time Remapping function to make each title slowly reveal, just as the camera crossed its position. Once the titles were in place and animated, it was safe to call this animation a true title sequence.

**Utilizing Particle Effects**

After graphical imagery was in place, cameras were animated and titles were in place, I started to add some advanced effects. These effects were the final touches which would bring much more life and movement to the production. To carry out these procedures, I used a plug-in called Trapcode Particular. Particular is a professional particle generator which is capable of simulating just about any particle imaginable (i.e., smoke, dust, fire, etc.). For this production, Particular was used to generate falling water effects as well as leaves and blossoms blowing in the wind and slow rolling mist. Below are the methods used to create these types of effects.

**Creating a Waterfall.** Once effects and footage was setup, it would all be brought into this composition for the final waterfall effect. Before I could start creating a waterfall, I needed a point of reference so I knew where to place the effect. I imported the PSD layer of the waterfall that was painted in Photoshop and placed it in the layers panel and locked it into position. I turned it into a Guide layer so that it would not be present when this finished comp was implemented into the Main Movie comp. I had the final comp setup, now I needed to make a source for Particular to generate its particles from.

I did this in another composition named “Waterfall Source” which was 500 by 30 pixels. I created a new solid layer (Layer > New > Solid) and named it “Source.” I then applied the Turbulent Noise effect to the solid (Effect > Noise & Grain > Turbulent Noise). I played with various settings within the effect like Contrast, Brightness and
Scale (see Figure 22), as well as the Evolution until I had a grayscale texture that had a smooth flowing motion to it. I added color to this effect by going to Effect > Color Correction > Colorama. I changed the colors to white and a very soft baby blue. My particle source was complete. I made a new 1080p composition named “Final Waterfall” and nested the Waterfall Source comp within it. I made it a 3D layer and moved it into position at a point on the top of the waterfall PSD layer where I wanted the particles to emit from. It was time to setup the particle generator, Trapcode Particular.

I setup Particular inside of the Final Waterfall composition. I created a new solid and applied Particular to it (Effect > Trapcode > Particular). At first glance, the many settings within this plug-in look daunting and it take some time to get familiar with them. The main objective was to get Particular to use the Waterfall Source composition as its emitter source. In the effects panel, I changed Emitter Type to “Layer,” and changed the dropdown menu under Layer Emitter to “Waterfall Source.” Just below that, I changed the dropdown menu for Layer Sampling to “Particle Birth Time.” Particular was then emitting particles from the Waterfall Source. The rest of the settings were adjusted to get the particles to fall correctly. Those settings and the ones mentioned above can all be seen in Figure 22.

Once I was satisfied with the effect, I nested the Final Waterfall comp into its respective scene composition. I turned it into a 3D layer so that it would be affected by camera movements, and positioned it slightly behind the PSD layer for the waterfall cliffs. Some final color adjustments were made with Levels, and Color Balance (Effect > Color Correction) to make the waterfall blend in with its environment.
Figure 22. The particular effects panel broken up into segments to display the settings for the waterfall effect.

Blossoms in the Wind. This effect was implemented in much the same way as above. I needed to create a particle source for Particular to emit. In this case I created a small flower pedal in Photoshop and imported it into After Effects and placed it into a new comp. I designated this layer as the particle source by going to the Particle dropdown menu and selecting “Sprite” for Particle Type (see Figure 23). Next, I went to the Texture dropdown and selected “Blossom” for the Layer setting. I could see this adjustment take place in my Composition panel, as Particular began emitting the flower pedal as its particle source. I gave them just a bit of rotation by making adjustments under the Rotation dropdown menu. To finalize the effect, I needed to make the flower pedals look weightless, as if they were drifting in the wind. This was done by playing with the
settings under the Physics dropdown menu which can be viewed in Figure 23. Once I was satisfied with the effect, it was brought into its respective scene composition, turned into a 3D layer and positioned accordingly.

![Figure 23. The particular effects panel settings for the falling blossoms effect.](image)

By creating a custom particle and setting up Particular to regenerate it at random and with variation, I saved the trouble of more tedious methods and was able to substitute the particle to create several animated effects of nature. For example, a small, cloudy brushstroke painted in Photoshop as a source replaced the blossom particle to create the mist effect that was used throughout the animation. With a new particle source and some slight adjustments, an endless number of effects could be created. (For in depth video tutorials on how to use Particular, visit [http://www.redgiantsoftware.com/videos/tutorials/#trapcode-particular](http://www.redgiantsoftware.com/videos/tutorials/#trapcode-particular).)
Rendering from After Effects

At this stage, I was ready to export the Main Movie composition as a video. Since rendering complex imagery is demanding on computer hardware and errors and crashes are known to occur, especially on lengthy productions, I decided to break up the renderings into four segments. This would produce four separate videos all equal in length that could later be merged together in video editing software.

To begin, I dragged the beginning and ending points of the “work area” bar to define a quarter of the segment I wanted to render (see Figure 24). I then opened the Render Queue (Composition > Make Movie) where all render settings would be input. There were three separate menus that needed to be addressed: Render Settings, Output Module, and Output To. Opening the Render Settings menu, the first item that needed to be addressed was the Quality setting which I set to “Best” (see Figure 25). Next, I made sure that “Full” was selected for Resolution. It was also important to double-check that the Frame Rate criteria was set correctly to “23.976.” I left all other settings alone and clicked “OK.”

*Figure 24.* The work area bar defining a segment to be rendered within the timeline.
Figure 25. The After Effects render settings menu ready for export.

In the Output Module settings, I needed to select the type of video file to render, as well as the compression. For the Format setting, I chose “QuickTime.” The Format Options button would be where the compression would be set. However, I did not want to compress the animation from After Effects. After Effects is best known for its ability to animate and create image effects, not for its video compression capabilities. There is software specifically developed for compression, which I would implement in later stages. Once I had selected the QuickTime setting, I was finished in this menu and clicked “OK.”
The final order of business in After Effects was to tell the software where to place the rendered QuickTime file, in the Output To menu. I simply chose the Desktop, named my file according to the segment of the animation that was being output (e.g., *Part_1*, *Part_2*, etc.) and clicked “Save.” Everything was ready to go and the Render button was clicked. I repeated this process for each of the four segments. Each one took a different amount of time to render depending on the complexity of their imagery and effects. In all, the time it took my computer to render all the segments was about an hour and a half. Once the wait was over, I had four uncompressed Quicktime videos that were each just over 6 gigabytes. They were ready to be pieced together and have music added (see *Video and Sound Editing in Adobe Premiere Pro*, below). My work in After Effects was finally complete.

Post Production: Video and Sound Editing

**Music Selection**

In doing some online research, I learned more about royalty-free music and found some good websites for obtaining reasonably priced music and licenses. Audiojungle, one of the online resources I discovered, had a great selection of professional quality music. The site layout was user-friendly, and the source material was well organized by category. By running some keyword searches within the website and listening to many different sound clips, I found a few good potential songs. To test them, I played my animation from After Effects while the songs played within my internet browser. The music and my animation were not yet edited or timed together, but this
method gave me a good enough idea of how they would work together and I was able to make a final selection of music.

The song I chose to accompany my title sequence was titled “Pan Asian Gymnopedie” by Gareth Coker. It opened with a gentle, meditative sound and the pacing was slow and steady enough to fit with the timing of my animation. The drums in the background eventually gain a bit of momentum to suggest the sense of adventure that I wanted to convey.

In order to use the song for my purposes I had to purchase it for fourteen dollars, which was very reasonable. Included with the download was a license granting me reuse of the song for my own work as well as permission to upload to the internet. The song file itself was in .wav and .mp3 formats which would be suitable to work with inside the editing software. Once purchased and downloaded, I was ready to add the music to my animation.

Video and Sound Editing in Adobe Premiere Pro

At this stage of production I had my completed animation in segments of four different Quicktime videos. I needed to merge them together so that they would play as a single video. During this process, I would also need to add the music that was to accompany my animation. The final editing tasks were completed in the Adobe Premiere Pro video editing software.

Once in Premiere Pro, I was first presented with the New Sequence window. I wanted to stay consistent with the same video settings that I had set for my animation inside of After Effects, so I selected the “AVCHD 1080p24” setting. Looking at the
In the Preset Description window, I could see that this setting was actually a frame rate setting of 23.976, which was exactly what I wanted. In the Sequence Name panel, I named my sequence “Final Movie” and clicked “OK” to proceed. My videos would all be placed within this sequence, similar to the way footage was placed inside of compositions in After Effects.

Once the settings were defined for the sequence, the Premier Pro workspace opened. At first glance, it looks fairly similar to that of After Effects since both programs are products of Adobe. Importing footage was done much the same way as in After Effects. I double-clicked inside the Project panel and browsed to my four Quicktime videos. I could then drag and drop the videos from the Project panel into the Timeline panel. I placed them in consecutive order and moved them along the timeline so they would play fluidly, without any breaks between them (see Figure 26). Premiere Pro does a good job at lining up footage so that it doesn’t overlap so the process of “stitching” the video together went fairly quickly. Once video was in place, I imported the MP3 song file that was to accompany the animation, and dropped it into the “Audio 1” track.

Figure 26. The Premier Pro timeline panel.
It was finally time to begin syncing music with the animation. By pressing the space bar on the keyboard, the animation would play back in the Preview panel and I could hear the audio along with it. By sliding the audio track within the timeline, I could change the way it synced with the video. This process took some time, as I wanted to have music and video work together harmoniously. Some slight edits needed to be made to the audio track to get things the way I wanted. I cut the audio track at a few points (Ctl+k) to snip out some areas of the song that didn’t flow with the animation. I also did a simple fade out at the end of the song. By selecting the audio track and then opening the Effects Control panel I could adjust the volume level by opening the dropdown menus, Volume > Level (see Figure 27). I then clicked the keyframe button at the point I wanted the music to begin fading out (“A”). I moved down the timeline and keyframed the second point where I would drop the volume (“B”), and pulled this keyframe down as far...
as it would go. There was now a slanting bar which represented the fading volume. At this point, I was satisfied with the cohesion of music and video and was ready to export the animation from Premiere Pro (see below).

Post Production: Compression and Output for Multiple Playback Devices

Considering Playback Devices

The rendering process in Premiere Pro would be much faster than it was in After Effects, since I was only dealing with four Quicktime videos and a single MP3 file. It was finally time to render these files out as the final playable version. To allow for the versatility of multiple playback options, I consciously created this production at a high image resolution. In order to determine how I would adjust the render settings, I needed to decide exactly how/where this animation would be viewed. I was certain that I would be uploading it to the internet, so settings needed to be made that would keep file size to a minimum, but without sacrificing significant image quality. Additionally, I needed to consider rendering a version that could be burned to a DVD to satisfy the requirements of the University for this thesis project as well as a high quality version which could be played on a computer for sharing and presentation purposes.

Compression and Final Output

In order to find what the best settings would be during the final render process, I did some tests by rendering out a few different file formats. Described here are the settings that I found to be most efficient. To render what would become the final playable animation for online streaming video, I opened the Export Settings window by going to File > Export > Media (For the purpose of this example, use Figure 28 for
Figure 28. The export settings in Premiere Pro for online playback.
reference). For the Format setting (“A”) I chose “H.264,” which is known for high compression rates while maintaining good image quality. Selecting to the right of Output Name opened the Save As window where I named the animation Beneath the Cherry Blossoms_1080p_web (“B”), and browsed to where I wanted the final product to be saved. I changed the inputs for Frame Width to “1,920” and Frame Height to “1,080” (“C”). The Frame Rate dropdown menu was set to “23.976” (“D”) and Pixel Aspect Ratio was set to “Square Pixels” (“E”). The Bitrate Settings box was very important in influencing file size and image quality. Lowering the Target Bitrate and Maximum Bitrates settings would significantly decrease file size, as well as image quality. Since this render was for web, I took Target Bitrate down to “10” and Maximum Bitrate to “30” (“F”). As I adjusted the sliders for these settings, the Estimated File Size number (“G”) dropped rapidly. I was satisfied when it read “161 MB.” All settings were adjusted the way I wanted and I selected the “Queue” button. Doing so opened the Adobe Media Encoder which is the software that would perform the compression and render of the animation. I simply selected “Start Queue,” and the render process began. Surprisingly, the animation only took around fifteen minutes to render. Once complete, I had my final movie title sequence animation at a file size of only 160 megabytes, which was a very suitable size for web playback.

For the final task of this production, I rendered a higher quality version for computer playback. All settings were the same as above except for the Bitrate Settings (see Figure 29). I set the Target Bitrate to “30” and Maximum Bitrate to “40” since I was not as concerned with file size and opted for a gain in image quality. Once rendered, this file came out to 580 megabytes – a significant increase in file size, but with only a slight
gain in quality and color vibrancy. This version would also be suitable for burning to a DVD in a burn program such as Nero or Roxio. It is very important to note, that when burning high definition footage to a DVD, a significant amount of image quality will be lost as DVD’s can only play at a resolution up to 720 x 480 pixels (480p).

At long last, after the use of seven different software applications and a series of multiple renderings from different programs, this production was in its final playable state. Since I setup this production at a high resolution, I had a variety of playback options and could share it with a wide audience. Although the uncompressed Quicktime videos rendered from After Effects were very large files, I would retain them along with the Premiere Pro file so that I would always have the option of rendering my project to a different format if needed in the future.
CHAPTER IV

REFLECTIONS, RECOMMENDATIONS,
AND CONCLUSION

Although every multimedia designer has a unique creative process and individual production pipelines may vary according to specific interests and objectives, it can be helpful to utilize the work of others. I realize that my Production Pipeline and detailed notes, as represented in Chapter III, Treatment of the Project, may not fit the goals or objectives of all multimedia designers. However, the detailed Treatment presented in Chapter III in conjunction with my recommendations below are meant to document the instrumentation of technology as well as the creative and organizational skills that may benefit others interested in motion design.

In this chapter, Reflections, Recommendations, and Conclusion, I will offer advice in the form of technical observations and personal discoveries made during the treatment and execution of my pipeline. From tools for creative development to an analysis of various software to the personal practices helpful for project management, I will detail the elements I feel were most significant in the production of Beneath the Cherry Blossoms.
Final Recommendations: The Importance of Pre-Production Work

Defining Your Pipeline

While it is not impossible to incorporate new ideas, methods, or inspiration along the way, thinking through the details of a Production Pipeline in the early stages of work is absolutely essential to balancing the creative, highly-technical, and professional aspects of producing a complex animated piece from start to finish (see Chapter III, Treatment of the Project). Indeed, the unexpected will arise and troubleshooting is unavoidable, but knowing the pipeline well will help the designer make the adjustments necessary in production to adhere to a final deadline. (For ideas on how to construct a production pipeline that covers conceptualization to final product see Chapter II, Current Motion Design, Production Pipeline.)

As a side note, when a multimedia designer runs into technical problems or tasks not taken into account in the production pipeline, it is important that they know where to go to get answers. If the answer cannot be found in a book, there are numerous online communities such as Creative Cow (www.creativecow.net), and Adobe Forums (www.forums.adobe.com) which specialize in answering technical questions via online help forums. It is in these forums you can post your questions and get answers from experienced professionals.

The Importance of Storyboards and Animatics

Clear communication and intriguing story are the responsibility of the multimedia designer. Fancy software and effects will not deliver a message alone, in order to finalize all concepts and put them in working order, the storyboard and animatic
are absolutely essential. During highly technical work in several different programs, these references will provide the creative maps of the animation that will prove most valuable. Furthermore, when done with careful consideration to practicality and a feasible timeline, these reinforce project management, and help identify the creative objectives that can often be lost in production.

Final Recommendations: Creating the Artwork

Combining Traditional and Digital Art

The hand-painted watercolor washes and dry brush strokes that I created and scanned into the computer were extremely helpful in digitally recreating a traditional painting style. While setting up custom brushes without the use of scanned textures directly in Adobe Photoshop and Corel Painter is certainly possible, they cannot fully simulate the look of real paint on paper. On the other hand, the ability of the software to combine and reproduce real world textures through the use of custom digital brushes, along with the advantage of image editing, makes it an indispensable tool, especially for the designer working on deadline.

Having previous traditional painting experience as well as a moderately established studio workspace with paint supplies on-hand, proved to be an added bonus in helping me create the paint textures and watercolor washes. Although I could have completed this production without incorporating any traditional media into my artwork, I don’t think I would have been as satisfied with the results. Experimenting with non-digital media and gaining knowledge of the fundamentals of art and traditional media,
especially acrylic and watercolor paints, provides a hands-on experience that will aid
anyone in their creative endeavors.

**Corel Painter vs. Adobe Photoshop**

Photoshop was developed first and foremost as “image editing” software,
which is why it has a plethora of tools available to manipulate and “tweak” imagery
(where traditional media is not as forgiving). However, the limited and less accessible
brush library and digital drawing/painting tools make achieving a natural effect difficult.
For adding a more traditional feel to digital artwork, Corel Painter acts as the perfect
counterpart to Photoshop. It has an extensive collection of digital brushes that simulate
traditional media—from watercolor and charcoal, to acrylic and oil pastel brushes—and it
is extremely well-organized and user-friendly.

The downside to Painter is that it is not as well-equipped for making
adjustments or fine tuning imagery as Photoshop. For example, the Layers panel in the
Corel workspace does not have as many features as Photoshop, which offers greater
versatility in terms of color adjustments and arranging or resizing imagery. This makes it
difficult to target specific areas of imagery for adjustment. Painter is more suited for
creating high-quality imagery with a minimal amount of layers, which can be imported
into Photoshop for easier editing. Utilizing Painter, alone, for a layer-intensive project
like this one would only prove to be rather limiting.

Without importing high-quality imagery from Painter, basic drawing and
coloring done in Photoshop and enhanced with Adjustment Layers, such as
Hue/Saturation, Levels, Curves, and Color and Contrast. Playing with these Adjustment
Layers or other various settings in the Adjustment Panel to see what other colors and
contrasts could be created frequently results in “happy accidents.” Image manipulation can also be done to imported scanned images of traditional artwork to produce custom digital brushes. The process can be time-consuming or fun depending how you look at it, but useful for future projects (see Chapter III, *Digital Drawing and Painting*).

**Final Recommendations: Animation Techniques and Effects**

**The Graph Editor**

Overall, camera animation was the most time consuming task of this entire production. While keyframing a camera from one point to the other could be done in a matter of seconds, adjusting it to have smooth and flowing movements without skips was not very straightforward. I had to spend a good deal of time inside the Graph Editor to manipulate points in order to perfect the movements. Though a tedious process, use of the Graph Editor was absolutely essential in being able to have complete control over keyframing the CG camera inside After Effects.

**Sure Target**

While I had used Sure Target with success in the past for less complex animations, I do not think it was the right plug-in for the type of camera work I did for this project. Sure Target is most efficient at moving from one targeted layer or Null to the other, with precision. By adapting it to perform more natural camera movements, I experienced more difficulty than in past experience. With a large project that required a lot of camera animation I had an overwhelming number of camera Nulls to manage and that seemed to make the process more cumbersome. If I were to perform the camera animation process for this project again, I would use a single Null object with each
camera to achieve movement and save Sure Target for a project it would be better suited for.

**Particle Effects**

While producing and compositing particle effects were fairly technical, the end results were well worth the effort. Trapcode Particular was very useful throughout this production and once I familiarized myself with its Effects panel, the process of generating custom particles and having them move the way I wanted became rather intuitive. The only drawback of using an advanced particle system was that it bogged down computer hardware and made playback in After Effects much more time consuming. This is why I would recommend adding all effects closer to the end of production, after the majority of camera movements and keyframing has been completed.

**Having the Right Hardware to Support the Software**

Most of the software used for this project required substantial computer hardware in order to operate at reasonable speed and efficiency during production. While the image creation software like Photoshop and Painter can work sufficiently on a standard desktop computer, animation and video editing programs require much more computing power to handle graphically rich imagery. This was especially the case while working with footage in the HD format inside of After Effects. The program requires significant RAM usage to operate, and at times it was using 95% of the 8 gigabytes of RAM on my desktop computer. My computer was customized to handle heavy workload, yet I still experienced occasional computer hang-ups and crashes.
When hardware reaches this point it is usually time to shutdown the software and restart the computer. Given that this was my first project in high-definition resolution and I will be conducting work in HD formats in the future, I will certainly be investing in more RAM. Doing so will increase computer speed and responsiveness, thereby increasing my work efficiency.

Final Recommendations: Video and Sound Editing

Finding the Music

I had a particular song in mind in the early stages of production. Unfortunately, I was unable to gain licensing permission from the record label. I had spent hours doing research and filling out forms only to be turned down. This was incredibly frustrating after the time I had spent perusing the music. Fortunately, I was able to find a royalty-free audio source at Audiojungle for a very reasonable price (see Chapter III, Post Production: Video and Sound Editing, Music Selection).

After my experience, I would caution multimedia designers to be hesitant of pursuing copyright permission from a large record company. For someone who simply needs a song for an animation or video production that is to be reproduced or uploaded to the web, royalty-free is the way to go. Websites like audiojungle.net, musicbakery.com, and musicrevolution.com have thousands of songs created by amateurs and professionals which are royalty-free. Some songs are free but usually higher quality music needs to be paid for.

Make sure to read exactly what the license allows you to do with the song before you purchase it. Usually there are restrictions against commercial use and
redistribution for profit. Others may specify how many times the song can be used, or even how many different websites it may be uploaded to at a given time.

**From Sony Vegas to Adobe Premiere Pro**

Before this project, I had mainly used Sony Vegas as the primary software for my video and sound editing needs due to its intuitive user interface. More specifically, what I liked about Vegas was how easy it was to import, cut, and rearrange audio and video footage. I also liked how efficiently it could create simple transitions and fades between footage. Unfortunately, when I began the final editing process for this project I came to realize just how limiting it was in terms of working with various video codecs.

After rendering my animation from After Effects as a Quicktime (.mov) video, I discovered that Vegas would not import .mov files. Rather than back-track to After Effects and completely re-render my animation to a format compatible with Vegas, which seemed counter-productive and extremely time-consuming, I decided to experiment with Adobe Premiere Pro.

Although I had used Premiere Pro before, I was not as familiar or comfortable with it as I was with Vegas. However, in spending some time reacquainting myself with the workspace and some main tools, I found Premiere Pro to be a much more advanced and efficient digital editing program than Vegas. I felt I could get down to the most tedious of details to make edits more precisely with both the video and audio tracks. I also really liked the fact that Premiere Pro gave a preview of footage in the Source panel, where I could make initial edits before I even brought it into the project timeline. One of the best features of Premiere Pro is that it jumps directly into Adobe Media Encoder to render and compress footage once a render is executed. Because of the limitations of
Vegas, I decided to use Adobe Premiere Pro to perform all final video and sound editing tasks for this project and will continue to use it for future projects. While Sony Vegas provides the most basic approach to adding audio “as is” or with very minor editing, any multimedia designer willing to take the time to become familiar with a more advanced-user interface will be pleased with the wider range of file compatibility and editing options in Premiere Pro.

**Final Recommendations: Compressing for Online Viewing**

In Chapter II, *Video Output Criteria*, I introduce the importance of utilizing separate software to compress footage rendered out of After Effects. To preserve image quality when rendering out of After Effects with the intention of compressing in another program, it is best to apply minimal compression or none at all.

As mentioned in the last section of Chapter III, *Compression and Final Output*, I had conducted a few render/compression tests of a shorter segment of my animation in order to determine the optimal settings for the final rendering, which I knew would be much more time-consuming. When comparing video files of the same size in H.264 (.mp4) format and Quicktime (.mov) format, I discovered that the H.264 video had slightly better image quality, which was especially noticeable in the vibrancy of the colors. I also liked the ability to make adjustments to the Bitrate sliders (see Figure 28), which gave full control over compression amount and quality. Taking time to find the best output settings at this final stage by rendering a few different versions of the project ensures that hard work put toward creating a large project won’t be ruined by poor playback quality.
Conclusion

In working with seven different forms of software for the completion of my movie title sequence, *Beneath the Cherry Blossoms*, I learned that an essential quality of the multimedia designer involves being able to adapt and hone an ability to learn new software. Through the experimentation and comprehension of a range of software, troubleshooting becomes a more carefree process as new abilities with technology provide more solutions to completing a given task or creative objective.

Whether working individually or on a production team, project management is perhaps the most crucial component to becoming an effective multimedia designer. From organizational skills, to scheduling of tasks, to planning and adhering to a production pipeline, being able to manage the project is just as important as creative abilities or technical know-how. Mapping out the pipeline in a more nitty-gritty fashion and scheduling deadlines for completion of the various stages of production provided necessary structure and better oversight of the work.

During the course of this project, days scheduled for animating occasionally became inspirational days for painting new textures and backgrounds (as weather and good natural lighting allowed). I found that my creative flow and acts of inspiration could be both productive and unproductive in the context of a large production. In this way, inspirational detours should be taken advantage of, to the extent that it doesn’t derail the end goal, especially in the case of professional engagements.

In addition to creative detours, mental roadblocks and dead-ends occur from time-to-time and so some tasks may not be completed in time for the estimated goals outlined within the framework of the pipeline. Having a Plan B (or in the case of a large
project, Plan C and Plan D), or having flexibility with the end result when possible, is always wise. I like to envision an analogy I once heard of bamboo—it is strong enough to hold up against the wind, yet flexible enough to move with it. Remember, the production pipeline is meant to be used as a tool to create the framework for determining tasks and scheduling the order of business and should be utilized to track time and address priorities, but ultimately, the designer is the Creative Director who has to make it work for them.
REFERENCES


http://audiojungle.net/

http://www.moviola.com/edu/rc/hd_ntsc_frame_rates


DEFINITION OF TERMS

1. 2.5D – The technique of having two-dimensional imagery exist in three-dimensional space within advanced animation software.

2. Alpha Channel – A portion of each pixel's data that is reserved for transparency information.

3. Animatic – A preliminary form of an animation or video production which allows the animator/filmmaker to study the pacing and flow of the production before it is finalized.

4. Animation – A simulation of movement created by displaying a series of sequential images or frames.

5. Bezier Curve – Used in image creation/editing software to model smooth curves that can be scaled indefinitely. "Paths," as they are commonly referred to are also used in animation as a tool to control the motion of elements.

6. Bitmap – A set of color data that represent a graphic image, with each bit or group of bits corresponding to a pixel in the image.

7. Cel – A transparent sheet of celluloid or similar film material that can be drawn or painted on, used in the production of animated films.

8. Codec – An algorithm, or specialized computer program, that reduces the amount of data for digital video. In practice, the term is used to refer to video compression formats.

9. Compositing – The combining of visual elements from separate sources into a single image, often with the intention of creating the illusion that all elements are parts of the same scene.

10. Composition – The thoughtful placement or arrangement of visual elements within an image.

11. Compression – The process of reducing the size of data within one or more digital files.

12. Computer Generated (CG) Camera – A virtual camera used within advanced digital software used to simulate the same effects as a physical camera.
13. **Contrast** – The use of opposing elements, such as colors, forms, or lines in proximity to produce an intensified effect.

14. **Digital Tablet** – Also known as a "graphics tablet" is an input device used to draw or create imagery on a computer screen without having to utilize a mouse or a keyboard.

15. **Dots-per-inch (DPI)** – A measure of spatial printing or video dot density, in particular the number of individual dots that can be placed in a line within the span of 1 inch.

16. **Footage** – The source material that is assembled to make up a scene or composition within digital image editing/manipulation software.

17. **Frame** – A single image/picture or still shot that is part of a sequential series of images that make up a video or animation.

18. **Frame-by-frame** – The process of creating sequential imagery one frame at a time in order to create the illusion of movement.

19. **Frame Rate** – The number of times per second that sequential images are played back to create the continuous illusion of movement.

20. **High Definition (HD)** – A new standard in television technology which provides higher resolution than standard-definition (SD) video, and most commonly involve wide-screen display resolutions of 1,280 x 720 (720p) pixels or 1,920 x 1,080 pixels (1080p).

21. **In-Between** – The frames lying between "key" frames or "extremes" which complete the illusion of movement of an element.

22. **Keyframe** – Nonadjacent frames that define the most major changes of movement of an element within a scene.

23. **Mask** – A parameter used to modify layer attributes, effect, and properties within digital software. The most common use of a mask is the modification of an alpha channel of a layer, which determines the transparency of the layer at each pixel.

24. **Motion Design** – The movement of graphical imagery and/or type over time for the purpose of delivering messages or communicating ideas.

25. **Motion Path** – A plotted course which provides control over the direction that elements travel in digital space.
26. **Multimedia Designer** – An individual who creates work using a wide variety of electronic tools and media. Their work generally consists of interactive artwork and video or installations comprised of animations, graphics and visual effects used for games, internet, movies, and broadcast.

27. **Nesting** – A technique used to implement an organized hierarchy by placing digital compositions within each other.

28. **Null** – A layer object which can be attached (parented) to other layers or elements to give more flexibility to how the object it is attached to can behave.

29. **Pan** – A camera technique that involves the movement of the camera on a horizontal axis.

30. **Parenting** – A hierarchical relationship which allows for relative movements between moving elements.

31. **Pixel** – The smallest unit of an image which is individually processed on a video display system (e.g., television screen or computer monitor).


33. **Photoshop Data (PSD)** – The native file format of the Adobe Photoshop graphical editing application.

34. **Post-production** – The final phase which occurs in the making of a media project. The term encompasses a variety of processes including editing, adding visual effects, sound design/effects, and final export of transferring of data.

35. **Pre-production** – The earliest phase which occurs in the making of a media project. This includes planning, testing, and any initial write-ups or sketches.

36. **Production Pipeline** – The framework of task organization for a given project.

37. **Render** – The process of generating a single image or series of images in the form of a digital video from a model, by means of a computer program. The result is a completed image or video the consumer or intended viewer sees.

38. **Resolution** – The height and width of a video measured in pixels.

39. **Static** – An image or picture that does not move.

40. **Storyboard** – A panel or series of panels of rough sketches outlining the sequence of events for scenes and major changes of action or plot for a production.
41. **Title Sequence** – A method by which cinematic films or television programs present the titles of key production and cast members, utilizing conceptual visuals and sound.

42. **Transition** – The change from one scene to the next.

43. **X-Axis** – Digital space represented horizontally.

44. **Y-Axis** – Digital space represented vertically.

45. **Z-Axis** – Digital space that is perpendicular to horizontal and vertical space.
STORYBOARDS

1. Camera draws near.
2. Head on waterfall.
3. Fall down, fade out.
4. Camera draws down to gates.
5. Camera draws down to gates.
6. Camera draws down to gates.
7. Camera draws near.
8. Head on waterfall.
9. Fall down, fade out.
Transition

Eyes into camera

Behind foliage

Pan right - to tilt right

Fade away foliage

Reveal band's hat to top

Camera through bamboo

E1

Fish swims out

Water ripple effect

Tilt right